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 Room for Change
Did you ever want to see what a room in your house would look 
like with a new coat of paint and some brand-new furniture before 
you ever visited your local home-improvement store or furniture 
outlet? Pete Collins puts on his interior decorating hat and shows 
us how to take a photo of a room, strip everything to the bare walls, 
and then realistically paint the walls and add furniture, plants, and 
picture frames—all in Photoshop. This is much more fun then 
cleaning all those painting tools and lifting heavy couches.
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 DOWNLOADABLE CONTENT 
Whenever you see this symbol at the end of an article, it means 
there are either downloadable practice files or additional content 
for KelbyOne members at http://kelbyone.com/magazine.

 What’s New in the 2015 
Release of Photoshop CC
When Adobe made the switch to the Creative Cloud, they promised 
regular updates to all of their applications, and so far they haven’t 
disappointed. Recently, they announced the availability of the 2015 
release of Creative Cloud, which included numerous new features 
and upgrades in Photoshop CC and a couple of very nice features 
in Lightroom CC. Corey and RC cover all the major new features 
and how they’ll improve your workflow and creativity. 

Corey Barker & RC Concepcion
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� KEY CONCEPTS 
These icons at the beginning of columns indicate there’s a short video on a tool 
or function used in that tutorial at the Key Concepts KelbyOne member webpage 

at http://kelbyone.com/keyconcepts.
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Before we get into all the stuff here in the mag (and it’s a really good issue!), I want to make sure you’re taking advantage of one 
of the best things about being a KelbyOne member (besides all the training), and that’s the ton of discounts we’ve arranged for 
our members on everything from plug-ins to prints, from books to backdrops, from flashes to office supplies, and everything in 
between. We have a long list of discounts—when you have a lot of members, companies start calling you to offer discounts to 
your members, which is awesome! 

I think the one that surprises our members most is that we have some pretty sweet member discounts directly from Apple. 
That’s right, we have a special version of the online Apple Store, created by Apple themselves, with discounts on Macintosh com-
puters and accessories. In many cases, the savings are pretty insane. (No, they don’t offer discounts on iPhones or iPads.)

For example, I just went to the regular Apple online store and configured a new iMac with Retina 5K display the way I would 
if I were buying one, then I went to the Apple Store for KelbyOne members and configured the exact same iMac, and the sav-
ings right there alone were $244. Heck, at that point, even if you’re not a creative professional, you’d still be better off joining  
KelbyOne first just to get that deal. And while the Apple deal is certainly a high-profile deal, there’s a laundry list of other compa-
nies that have offered some amazing deals, so make sure you log in to the members-only website (www.kelbyone.com) to see 
your deals and get your discount codes. Members tell us all the time that they pay for their KelbyOne membership each year with 
the money they save on hardware and software, and that’s music to our ears and why we pursue these discounts for our members.

Having things like these discounts, our one-on-one tech support when you get stuck in Photoshop or Lightroom, and a monthly 
magazine created just for members that’s more than 100 pages each issue (that’s 1,000+ pages of cool stuff right there each year) 
are what makes us different than a subscription. Here, you’re a member. You’re a part of a community that’s much more than 
just online training; but we put such emphasis on the classes we release every week that it’s easy to miss all the other stuff we 
do for you all year long. That’s why I wanted to take a few minutes to remind you to take advantage of all these benefits—stuff 
you don’t find anywhere else—that were created to make your membership more valuable. Today, that means a lot to all of us.

Hey, since you’re holding one of my favorite member benefits in your hand, let’s take a quick peek at what we have in store 
this issue: We have a theme going on here, and we’re kicking it off with our main feature: “Room for Change” by Pete Collins 
(p.62). Have you ever considered using Photoshop to explore how a room in your house would look with different colored walls 
and new furniture? Pete will bring out the interior decorator in you with this step-by-step tutorial showing exactly how you can 
do just that. Also, in our “Beyond Photoshop” column (p. 58), Scott Onstott shows how to change the color of your house in 
Photoshop without ever opening a can of paint.

For you photographers out there, our “Photography Secrets” column (p.74) is “Ten Secrets for Architectural Photography” by 
Randy Van Duinen, who shares from his decades of experience what he’s learned when it comes to shooting exterior and interior 
spaces. In our “Light It” column (p.80), Randy takes us inside to show us how to light a commercial space using tungsten lighting.

Of course, the latest issue of Lightroom Magazine (our magazine within a magazine) is here as well, and it’s packed with all the 
Lightroom stuff that you want to know, especially since Adobe just snuck a few new features into Lightroom CC.

Lots of cool stuff in the entire mag, and I hope you’ll take advantage of all the other cool things that come with being a KelbyOne 
member. We’re glad you’re with us, and the best is yet to come!

All my best, 

Scott Kelby
KelbyOne President & CEO
Editor & Publisher, Photoshop User

From the Editor
 online classes are just one part 
 of being a kelbyone member
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Photoshop User 
Magazine
Photoshop User magazine is the official publication of 
KelbyOne. As a KelbyOne member, you automatically 
receive Photoshop User delivered right to your door (or 
digitally) ten times a year. Each issue features in-depth 
Photoshop, Lightroom, and photography tutorials writ-
ten by the most talented designers, photographers, and 
leading authors in the industry.

KELBYONE 
is the world’s leading resource for Adobe® Photoshop®, Lightroom®, and 

photography training, news, and education. Founded in 1998 as the National 
Association of Photoshop Professionals (NAPP), KelbyOne has evolved from 

NAPP and KelbyTraining to create a singular hub for creative people to learn, grow, 
and inspire. From photographers to graphic designers, beginners to professionals, 

KelbyOne is open to everyone.    

There’s no faster, easier, and more affordable way to get really good at Photoshop 
and photography. You can join for only $19.99 per month or $199 U.S. for a full 

year of training. To learn more, visit www.kelbyone.com.

 

PHOTOSHOP USER MAGAZINE 
Ten issues of the best Photoshop tutorial-based magazine in the industry.  

MEMBERS-ONLY WEBSITE 
Our extensive website features time- and money-saving content.

ONLINE CLASSES & EDUCATION 
Thousands of Photoshop and photography tutorials, full online classes,  

and quick-tip videos. 

MEMBER DISCOUNTS 
Save anywhere from 2–4 times your membership cost by using our many 
industry-related discounts.

TECH SUPPORT 
Fast, friendly Photoshop, Lightroom, and photo gear help; equipment 
advice; and more from certified experts.

MEMBER COMMUNITY 
KelbyOne members range from beginners to pros and love to lend each 
other a hand. Together, we have built the friendliest, most knowledgeable 
Photoshop and photography community on the Web.

NEWS & REVIEWS 
Unbiased coverage on the latest equipment, plug-ins, and programs 
in the marketplace.

WEEKLY E-NEWSLETTER 
The KelbyOne Insider is your weekly connection to everything KelbyOne.  
It’s produced exclusively for members to keep you informed of everything 
new in the industry and at KelbyOne headquarters.

FIND KELBYONE MEMBERSHIP DETAILS AT kelbyone.com or call 800-201-7323 Monday–Friday, 9:00 a.m. to 5:30 p.m. EST.

About KelbyOne

Member Benefits

http://kelbyone.com
http://kelbyone.com
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›  › Inspiration, information, and member musings to fuel your creative think tank
BY HEATHER SHORTT

KelbyOne Community

It’s Good to Be a  
kelbyone member
There’s just something about belonging to a group or a community that makes us feel all warm and fuzzy inside. Continu-
ously add learning and membership perks and, well, that’s just the icing on the cake. That’s what you get when you’re a 
KelbyOne member. We’re here to evolve your skills in Photoshop, Lightroom, photography, and many more areas, plus give 
you a sense of belonging to a community that helps inspire your creative growth. If you’re a member, here’s a rundown to 
make sure you’re taking full advantage of your membership. And if you’re not, here are four different really big, really awe-
some features of a KelbyOne membership that you’re missing out on. 

Amazing classes: We hate to brag, but hands down, we have the best training out there. We truly believe quality matters. 
That’s why all KelbyOne courses are produced by an award-winning team that creates quality, cinematic-style productions 
that put you right there with the instructor. It’s the very best way to learn. Plus, we drop a new course every week with fresh 
content on the subjects you want to learn. 

Brilliant teachers: We all know the difference a great teacher makes, and that’s why we only use the most talented, engaging, 
and respected instructors in the industry. Our instructors make teaching their passion and they believe that learning should be 
simple, fast, and fun. You’ll never end a class scratching your head in confusion. Instead, you’ll say, “Wow! I never thought 
I could learn that.”

Bonus content: If you’re reading this now, you’re probably a fan of Photoshop User. I mean it’s more than a magazine; 
it’s like a really cool Photoshop, Lightroom, and photography book all in one. It’s produced 10 times a year and comes 
with membership. That’s a $100 value in the magazine alone. Rumor has it some members save every issue to refer back 
to—and who wouldn’t? At the end of just one year, you’ll have accumulated an entire reference library of some of the 
best tutorials around. 

Exclusive discounts: What would a membership be without a few bonus perks? And we have way more than a few. We 
negotiate special member-only discounts on everything from camera gear to software, from laptops to lighting, from plug-ins 
to printing, and everything in between. These discounts are from serious industry players too: Apple, B&H, Macphun, Square-
space, Google Nik Software, and many more. The savings can more than pay for your membership. 

We could go on and on with more reasons to love being a KelbyOne member—The Photoshop Guys, special insider events 
and news, challenges and contests, member-only webcasts—but we’ll leave you with this: There’s no better place to fuel your 
creativity, grow your skills, and be a part of a community of creative folks just like you. To our members, we thank you. To 
our future members, what are you waiting for? Visit www.KelbyOne.com to learn more.

The Power
to create
What happens when you get Canon, Adobe, and KelbyOne playing in the same space? An incredible bundle offer is created 
to bring serious value to our customers. The Power to Create bundle is the ultimate package to capture, edit, and enhance 
great photos. 

Here are the specifics: Right now through October 3, 2015, when you buy a Canon EOS 7D Mark II, EOS 5D Mark III, or EOS 
6D, you’ll receive a complete set of tools and training from Adobe and KelbyOne. This includes a one-year membership to the 
Adobe Creative Cloud Photography Plan (Adobe Photoshop CC and Adobe Photoshop Lightroom CC—a $119.88 value) and 
a one-year membership to KelbyOne’s learning library that features hand-selected courses designed to get you up to speed 
with your new gear and programs (a $119 value). 

This powerhouse of a package sets up any photographer for success by providing the exact tools he or she needs to create 
powerful images—for less. Learn more at http://kel.by/canonpowertocreate.

http://kelbyone.com
http://kel.by/canonpowertocreate
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#KELBYONECHALLENGE WINNER: THE FLOWER SHOT

ARTIST SPOTLIGHT  › › VINH TIEU 
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#KELBYONECHALLENGE WINNER: FATHER’S DAY
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Fresh New Classes 
	 released at kelbyone.com

Here’s a roundup of our latest classes and tutorials that 
you won’t want to miss. Log into your member account at 
www.KelbyOne.com or check out these new releases on 
our app. Not a member? You can try KelbyOne for free. 
Visit www.KelbyOne.com/freetrial to view these classes 
and more. 

What’s New in Photoshop CC 2015
Join Photoshop guru Corey Barker as he gets you up to 
speed on all the newest features in the 2015 release of 
Photoshop CC. This new update is perfect for design-
ers, featuring new artboards and enhanced layer styles. 
Photographers will also benefit from the new Gallery Blur 
and Content-Aware features and so much more. Be sure 
to check out Corey’s article in this issue on the new fea-
tures in Photoshop, as well. It’s just a few pages away 
on page 20.

Active Lifestyle Photography
Get up and moving with Erik Valind in his latest class on 
active lifestyle photography, which is all about captur-
ing believable moments and showing that ideal reality in 
an image. Working with natural light, reflectors, studio 
strobes, and off-camera flashes, you’ll get a good handle 

on how to tailor your lighting to fit the mood of the scene 
so you can capture those hero images at the peak of action.

Getting Started with Dreamweaver 
Join Janine Warner, author of the Dreamweaver for 
Dummies series, as she teaches you the basic skills every 
Dreamweaver user needs to know to start building and 
managing a website. Whether you’re completely new to 
Dreamweaver or just looking for a refresher, Janine will 
take you step by step through the process of setting up a 
simple website, creating new pages, adding and format-
ting text, inserting images, controlling the layout, and 
then linking it all together.

Photoshop World 
has arrived
Soon after you read this, I’ll have jetted my way across the country to a quaint, little town called Las Vegas (can you tell I’m a 
first-timer?) to attend the industry’s most exciting, most spectacular learning event of the year: Photoshop World Conference 
& Expo. At KelbyOne, we spend all year making sure each show is better than the last. To help guide you along the way, here 
are a few things on my watch list that I can’t wait to check out at Photoshop World 2015. 

The Opening Keynote: The Opening Keynote is a must-attend event for anyone, whether you’re a first-timer or a conference 
alum. It’s a tone-setting, highly entertaining, electrifying launch party. It features Scott Kelby and The Photoshop Guys, and 
as we all know, antics, hilarity, and surprises are sure to ensue whenever these guys get together. Plus, you’ll be the first to 
hear all the breaking industry news, updates, presentations, and announcements from Adobe, KelbyOne, and more! 

Live natural-lighting shoots: This is a new feature and I think a lot of attendees are just going to go bananas over it. On 
Wednesday from 11 a.m. to 4 p.m., there will be live shooting opportunities open to all attendees. With four shoots to choose 
from—food, model, macro, and even a wedding shoot—you’ll be able to test your skills in a professional setting. 

Midnight Madness: This is appropriately nicknamed “The Session for Photoshop Freaks Who Just Can’t Sleep.” Why would 
you want to miss this? My first experience with Midnight Madness was in Atlanta. People were lining up to run through the 
double doors. It was, well, madness. While we learned next to nothing about Photoshop, it was a fun, laid-back event where 
we could relax after a full day of learning. I can only imagine what a Vegas-style Midnight Madness has in store. 

Expo Floor: I don’t know about you, but I’m a shopaholic and a hands-on kinda girl. So if I can peruse the showroom floor 
packed with vendors, onsite demos on my favorite products, plus live free training, count me in. What you won’t want to miss 
is the Westcott booth, where you can shoot live models in professional setups. They’ll have a total of six different costumes 
and themes, including steampunk, ice princess, the Incredible Hulk, and more. Make sure to bring your cameras; you won’t 
want to miss the opportunities at the Expo.

That’s just a glimpse at a few of the must-see opportunities we pack into the three-day learning extravaganza we call Photoshop 

World. I can’t wait to see how this show makes a fan out of you. ■

http://kelbyone.com
http://kelbyone.com
http://kelbyone.com/subscribe/
http://photoshopworld.com
http://photoshopworld.com
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BY CHRIS MAIN

Adobe Creative Cloud
enters 2015
On June 16, Adobe announced the 2015 release of the Creative Cloud. This release included updates to just about everything in 

the Cloud, including Photoshop, InDesign, Illustrator, Premiere Pro, After Effects, Dreamweaver, and more. They also updated and 

announced some new mobile apps. New features in InDesign include speed improvements (up to twice as fast as CS6), placing 

images in table cells, easily publishing documents online, and paragraph shading. Illustrator is 10 times faster than in CS6, offers  

10 times greater zoom magnification, and allows you to create custom graphs, charts, and infographics.

But, of course, our main interest here in the magazine is Photoshop CC and Lightroom CC. That’s why we asked Corey Barker 

and RC Concepcion to give us all the juicy details starting on page 20. For more on all of the other updated applications and fea-

tures, including the new Adobe Stock service, visit www.adobe.com.

OWC Announces the New USB-C Dock
available for pre-order
Other World Computing, otherwise known as OWC, recently announced a new USB-C Dock for the 2015 Apple MacBook 

and other computers that use USB-C ports. Available in silver, space gray, and gold, the dock sports 11 ports: Five fully pow-

ered USB 3.1 ports; one full-speed Gigabit Ethernet port; one HDMI port; one Secure Digital (SD) card reader; two audio ports, 

including audio in and audio out; and one USB-C port. Users will be able to charge devices, connect displays and external 

storage, import photos, connect audio accessories, and even power their MacBook. The OWC USB-C Dock will be available 

in the fall, but can be pre-ordered for $129 for a limited time. For more information, visit www.macsales.com/usbcdock.

Exp  sed: Industry News
The latest news about photography gear, software, and services›  ›

The DxO ONE for Your iPhone
may make your dslr jealous
DxO, the makers of OpticsPro, has announced a new camera for your iPhone: the DxO ONE. This 3.8 oz camera shoots 20.2-mega-

pixel images using a high-quality f/1.8, 11.9mm (equivalent to 32mm in full frame) aspherical lens with a variable 6-blade iris and  

1" CMOS BSI sensor. The DxO ONE attaches to the iPhone’s Lightning connector and uses the iPhone’s display as the viewfinder. 

The free iOS app controls the aperture (f/1.8–f/11), the shutter speed (15s–1/8000), and ISO (100–51,200). In addition to the 

built-in microSD card, photos and video can also be stored on the iPhone’s camera roll. By default, the DxO ONE keeps the RAW 

(DNG) files. It also records videos at 

1080p/30fps or 720p/120fps. The 

DxO ONE should be available in 

September for $599. For more infor-

mation visit www.dxo.com.

http://www.adobe.com
https://eshop.macsales.com/shop/usb-c/owc/usb-c-dock
http://www.dxo.com/us/dxo-one
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 ›  ›  e x p o s e d :  i n d u st r y  n e w s

More Solutions 
from tethertools
In the second installment of Scott Kelby’s “Lightroom Questions & Answers” column 

in this issue, a reader asks Scott how to prevent a tethered connection from dropping 

out during a shoot. While you can turn to page 111 for Scott’s answer, TetherTools has 

a hardware solution that addresses this very same issue, and it’s called the TetherBoost 

USB 3.0 Core Controller. It’s designed to boost and regulate power from a DSLR camera 

or Digital Back. This helps maintain a stable, reliable connection when you connect your 

camera to a computer via USB.

And in the last issue (July/August 2015, p.109), Michael Corsentino reviewed the new 

Digital Director from Manfrotto. This hardware-and-software solution turns your iPad 

into a field monitor and allows you to control your camera. TetherTools has introduced 

the JerkStopper for Digital Director. The JerkStopper securely attaches to the Digital Director and holds both the USB and AC power 

cables securely in place. This prevents the cables from being “jerked” out and protects the USB and power ports.

The TetherBoost Core Controller is available for $54.95 and the JerkStopper for Digital Director is $32.95. Visit www.tethertools.com 

for more info.

Nikon Announces 
three new lenses
Nikon has added three new lenses to its lineup: the AF-S DX NIKKOR 16–80mm f/2.8–4E ED VR; and two FX super telephotos—the 

AF-S NIKKOR 500mm f/4E FL ED VR and the AF-S NIKKOR 600mm f/4E FL ED VR. Now that your head is swimming with letters and 

numbers, let’s try to break this down.

The AF-S DX NIKKOR 16–80mm f/2.8–4E ED VR is a fast lens for shooting everything from wide-angle landscapes to portraits. It’s 

the first Nikon DX-format lens with Nikon’s exclusive Nano Crystal Coat. This advanced optical coating reduces ghosting and flare. The 

front and rear elements also integrate a fluorine coating to make it easier to clean the lens surface. This is also the first Nikon DX lens to 

feature an electromagnetic diaphragm, which electronically adjusts the aperture within the lens, resulting in consistent exposure during 

high-speed shooting. The lens also features four Extra-Low Dispersion (ED) elements and three aspheric elements to further combat 

instances of ghost, flare, and chromatic aberration. The lens is constructed of 17 elements in 13 groups, and features a seven-blade 

diaphragm to create a circular, natural bokeh for a pleasing out-of-focus area of the image. 

The design of the two new FX-format super telephoto NIKKOR lenses significantly improves AF tracking performance, helping pho-

tographers capture images of wildlife or athletes. Both lenses use Nikon’s Electromagnetic Diaphragm, and the addition of fluorite lens 

elements helps to reduce chromatic aberration, as well as decrease the overall weight of the lenses, saving nearly 2 lbs for the 500mm 

f/4E FL ED VR, and nearly 3 lbs for the 600mm f/4E FL ED VR. For extended shooting days in the field, the AF-S NIKKOR 500mm and 

600mm lenses also employ magnesium alloy construction for enhanced durability and further weight reduction. Both lenses include 

Nikon’s Nano Crystal Coat, and incorporate Nikon Vibration Reduction (VR) technology, affording up to four stops of image stabilization.

The new Nikon AF-S DX NIKKOR 16–80mm f/2.8–4E ED VR will be available for a suggested retail price of $1,069.95. The new AF-S 

NIKKOR 500mm f/4E FL ED VR and the AF-S NIKKOR 600mm f/4E FL ED VR will be available for suggested retail prices of $10,299.95 and 

$12,299.95, respectively. For more information on NIKKOR lenses as well as other Nikon products, please visit www.nikonusa.com. ■

http://www.tethertools.com
http://www.nikonusa.com/en/index.page
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Adobe recently announced the availability of the 2015 release of  

Creative Cloud, with major updates to Photoshop CC. This time 

around it was largely an upgrade for graphic designers, but there 

are a few exciting new features for photographers as well, including  

a couple of cool new features in Lightroom CC. This update incor-

porates a lot of features that designers already identify with in other 

Adobe applications such as InDesign and Illustrator, so let’s take  

a quick peek at these new features.
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device whenever you make a change. Whether you’re 
designing an app or just want to preview your designs on a 
mobile device, this feature makes it much easier.

CONTENT-AWARE UPDATES
Content-Aware technology has been evolving for some 
time now in Photoshop and it has made another leap for-
ward in Photoshop CC 2015. The Content-Aware Move 
tool (nested under the Spot Healing Brush tool [J] in the 
Toolbox) now allows you not only to move an object to a 
new location but you can also scale and rotate the selec-
tion before it applies the Content-Aware Fill. This gives you 
greater flexibility with fewer steps. Like all uses of Con-
tent-Aware, the accuracy varies and, in some cases, will 
need a little touching up, but it still gets you farther along 
in the process much more quickly.

FINALLY, ARTBOARDS IN PHOTOSHOP!
If you’re a working designer and have used InDesign or 
Illustrator, then you’ll most certainly find this a welcome 
addition to Photoshop. You can now create multiple art-
boards in a single document, allowing you to work on 
multiple projects, or perhaps multiple versions of a project, 
all at once. You can 
easily create custom 
artboards using the 
Artboard tool (nested 
under the Move tool 
[V] in the Toolbox), or 
choose from a variety 
of artboard presets 
for mobile devices or 
Web platforms in the 
Options Bar when the 
Artboard tool is active. You can also find the artboard pre-
sets in the Properties panel.

DEVICE PREVIEW
This handy feature allows you to live preview your Photo-
shop files (including artboards) on your iPhone or iPad using 
the Adobe Preview CC companion app (the Android ver-
sion isn’t available yet). Simply install the Adobe Preview CC  
app from the App Store, sign in with your Adobe ID, and 
then make sure that both your computer and mobile 
device are on the same Wi-Fi network, or you can con-
nect your mobile device via USB. Either way, simply open 
the Device Preview panel (Window>Device Preview), and 
then you’ll see your active Photoshop file (or artboard) on 
the device. Your design will automatically update on your 
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The problem with stitching panoramas in Photoshop 
in the past was that you either had to crop the final 
image because of missing areas around the edges of the 
stitched image, or you could give Content-Aware Fill a try 
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MULTIPLE LAYER STYLES
This feature is a minor victory for designers and, if you’ve 
been using layer styles for a while, you’ll certainly appre-
ciate it. You can now add multiple instances of the same 
layer style within a single layer, eliminating the need to cre-
ate a null layer to add a second drop shadow or stroke, 
for instance. In the new Layer Style dialog, some of the 
layer styles in the list of Styles on the left have a plus sign 
next to them. These are the styles that can be duplicated, 
and yes, they’re limited to Stroke, Inner Shadow, Color 
Overlay, Gradient Overlay, and Drop Shadow. When mul-
tiple instances of a style are created, you can rearrange the 
stacking order within each group by highlighting the style 
you want to move in the list of Styles, and then clicking 
the up and down arrows at the bottom of the dialog. One 
thing to keep in mind is that this feature is sticky: It will 
remember if you have multiple instances of a style the next 
time you apply it to another layer.

LINKED LIBRARY ASSETS
One of the most exciting parts about updates to Adobe 
applications such as Photoshop is how much of the Creative 
Cloud is leveraged with each new version. Keeping your 
assets in your Cloud libraries not only ensures that they’ll 
never get lost, but it also allows you to access them from 
anywhere. You now also have the benefit of linked assets, 
which means that when you bring a graphic element into a 
working document from your cloud-linked Libraries panel 
(Window>Libraries), it will place the graphic as a Creative 
Cloud smart object. So, if you manage a design team and 
want to make sure the assets stay consistent, you can share 
your master library folder. As you make changes to any of 
the master files, other users will be prompted that some-
thing has changed, and they’ll have the option to update 

and hope for the best. Well now that feature is part of 
the Photomerge process (File>Automate>Photomerge), 
which means that you can have Photoshop apply the Con-
tent-Aware Fill as it’s stitching the images together. Just 
select the Content-Aware Fill Transparent Areas option 
in the Photomerge dialog. This method is better because 
Content-Aware Fill determines the fill by using the data of 
the original photos, not after the stitching, when much of 
the image data has been stripped away.

GLYPHS PANEL
Another welcome carryover from InDesign and Illustrator 
is the new Glyphs panel (Window>Glyphs), which allows 
you to see all the glyphs that are available with a particular 
font. Once you choose a font, you can filter the results 
to see the entire glyph set or just specific sets such as 
Punctuation, Currency, Numbers, etc. Another interesting 
feature for the Glyphs panel is that you can use the slider 
at the bottom to change the magnification of the overall 
menu, but use the icons at the bottom right of the panel to 
decrease or increase the size of the glyphs, without chang-
ing the size of the grid in which they appear. This is really 
helpful if a font has rather small glyphs and it’s a valuable 
addition if you’re a designer who works a lot with type—
unless, of course, you just happen to know every glyph of 
every font by heart!
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Smart filters (Filter> 
Convert for Smart 
Filters) have been 
around for quite 
some time in Photo-
shop; however, they 
were limited in their 
support of the fea-
tures found under 
Image>Adjustments. 
In fact, you could 
apply Shadows/High-
lights as a smart filter; but now you can apply just about 
any adjustment that appears under the Image>Adjust-
ments menu as a smart filter (except for the four at the 
bottom). Applying these adjustments as smart filters is a 
useful alternative to adjustment layers, and they’re both 
nondestructive methods.

BLUR NOISE
Another handy feature that photographers can be excited 
about can be found in the Filter>Blur Gallery: the ability to 
bring back noise. The problem with blurring an image is 
that it blurs the original noise grain as well, which tends to 
make it look unrealistic, and it can also produce banding 
when printed. Now you can apply the blur and then bring 
back the noise (whether monochromatic or color) using 
the Noise panel in the Blur Gallery, thus keeping the integ-
rity of the image with its original grain.

the content. This is a great use of the Cloud and a great 
way to ensure up-to-date content.

NEW EXPORT FEATURES
The Export features have been given a much-needed 
update. You now have the ability to export specific assets, 
such as a particular artboard, within a document or a 
single layer (Right-click on the layer in the Layers panel 
and select Export As). The new Export As dialog (File> 
Export>Export As) has essentially replaced the Save for 
Web dialog (which is still available as a Legacy feature). It’s 
been stripped down to the most-needed features, mak-
ing it more streamlined, with better compression and pre-
view options. If you export often to a specific file format, 
you can use the Quick Export feature (File>Export>Quick 
Export) using settings you designate in the Export Prefer-
ences (File>Export>Export Preferences).

REAL-TIME HEALING BRUSH TOOL
This may seem like a small thing, but if you do a lot of 
portrait retouching and such then you’ll appreciate this 
enhancement. In prior versions when you used the Healing 
Brush tool (nested under the Spot Healing Brush tool [J] 
in the Toolbox), you’d paint over the targeted area and 
Photoshop would run the adjustment after you released 
the tool. Now, the correction is made as you paint over 
the area in real time. The Spot Healing Brush tool and the 
Patch tool have also been enhanced and run much faster 
than in previous versions. 

SMART FILTER ADJUSTMENTS
Another win for photographers and retouchers is the 
ability to adjust images in more nondestructive ways. 
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DESIGN SPACE
This last feature is pretty cool but it’s technically just a 
preview of some new UI technology Adobe is developing. 
In the Photoshop CC (PC: Edit)>Preferences under Tech-
nology Previews, you can Enable Design Space (Preview). 
This is a simplified design interface that gives you only the 
essential features for working on a design project. It maxi-
mizes screen area for your image and has what is basically 
an enhanced Properties panel that displays the relevant 
features to whatever tool you’re using. It also includes a 
cleaner more streamlined Layers panel. To switch back 
and forth between the standard Photoshop space and the 
Design Space, simply go under the Window menu and 
choose either Return to Standard Photoshop or Design 
Space (Preview). Again, this is merely in preview phase, but 
it’s exciting that Adobe is introducing this technology so 
that users can provide feedback and help shape the future 
of what Photoshop can become. 

OTHER FEATURES
That pretty much covers the major features of Photoshop 
CC 2015. (To learn more about other new features, plus 
JDI [Just Do It] fixes, visit https://helpx.adobe.com/ 
photoshop/using/whats-new.html.) In addition to 
new features in Photoshop and other Creative Cloud 
apps, Adobe has announced another new product: Adobe 
Stock. This massive stock library is available as a separate 
pay service, but it’s integrated into your Creative Cloud 
and can be accessed from the Libraries panel in Photoshop 
and other Adobe apps, such as Illustrator and InDesign. 
Again, another leap to streamline the process and get you 
doing what you do best—create! 

Lightroom CC 2015 also received a couple of cool 
additions to its photographic arsenal. With new 
features in both the desktop and mobile applica-
tions, I think users will really get a kick out of what 
Adobe has brought to the table. It’s also worth 
pointing out that these changes will only be avail-
able to Creative Cloud subscribers; individuals 
who have purchased Lightroom 6 as a standalone 
program will not receive these updates. And don’t 
forget that the new Lightroom features are avail-
able in Adobe Camera Raw, as well.

DEHAZE ADJUSTMENT SLIDER
Located in the Effects panel in the Develop mod-
ule, the Dehaze slider lets you control the amount 
of atmospheric haze you have in a picture. Not 
only does it reduce haze with just a simple slider, 
but you can also add haze to a picture to give it a 
cool atmospheric effect. 

WHITES AND BLACKS SLIDERS  
IN KEY DEVELOP TOOLS
I’ve always missed having the Whites and Blacks 
sliders in the Adjustment Brush (K). Adobe has not 
only included these two sliders in the Adjustment 
Brush but also added them to the Radial Filter 
(Shift-M) and Graduated Filter (M) too!

UPDATES TO LIGHTROOM FOR MOBILE
The mobile app of Lightroom now gives you 
more control over color and tone with the new  
Color/B&W and Tone Curve adjustment tools. 
You can also add vignettes to your images, and 
even view and share videos that are in your collec-
tion right from the app! ■

http://helpx.adobe.com/photoshop/using/whats-new.html
http://helpx.adobe.com/photoshop/using/whats-new.html
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&
Down

Dirty
Tricks

Sometimes you just want to take a good photo and make it even 
better. When it comes to adding lighting effects, you want to use as 
much of the existing light in the photo as possible. In this tutorial, 
we’re going to explore a few layer and brush tricks to enhance the 
lighting in your photos.

enhanced lighting effects
B Y  C O R E Y  B A R K E R
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Step One: Start with a photo where you want to enhance the 

lighting. This photo is composed nicely and shot in good light; 

however, we can enhance it with more dramatic lighting using 

what’s already in the photo. You can download this image and 

follow along to learn the basic concepts, then try variations of 

this technique on your own images.

[KelbyOne members may download the file used in this tuto-

rial at http://kelbyone.com/magazine/issue/september_2015. 

All files are for personal use only.]

Step Two: Press Command-J (PC: Ctrl-J) to make a duplicate of 

the Background layer. Press Command-U (PC: Ctrl-U) to open 

the Hue/Saturation dialog. Check Colorize on, set the Hue to 

around 33, and leave the Saturation at 25. Click OK.

Step Three: In the Layers panel, change the layer blend mode to 

Multiply and drop the layer Opacity to around 55%. This will put 

a warmer cast over the image and will crush the shadows a bit.

Step Four: Click on the original Background layer to make it 

active and duplicate it again by pressing Command-J (PC: Ctrl-J).  

Reposition this layer above the color-cast layer in the Layers 

panel, then change the layer blend mode to Soft Light, and drop 

the layer Opacity to 75%. This will compensate for some of the 

vibrancy that was lost in the previous step. 

Step Five: Let’s add a simple lens flare to enhance the light 

source in the image. We want the ability to edit the lens flare 

after it’s created, so we need to create it on its own layer. Click 

the Create a New Layer icon at the bottom of the Layers panel, 

press Shift-Delete (PC: Shift-Backspace) to open the Fill dialog, 

set the Contents drop-down menu to Black, and click OK to fill 

the layer with black.

Step Four

Step Five

Step One

Step Three
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Step Six: Go to Filter>Render>Lens Flare. Make sure the 

50–300mm Zoom option is selected and increase the Brightness 

to 115%. Click in the preview window and move the center of 

the flare to the upper-left corner, roughly in the same place where 

the light in the image is coming from. Click OK when done. 

Step Seven: Change the layer blend mode to Screen to blend 

the flare with the rest of the image. We actually need to place 

the flare just beyond the top of the image boundary, but the 

Lens Flare filter won’t allow you place the center of the flare 

outside the edges of a document. Press Command-T (PC: Ctrl-T) 

to activate Free Transform, hold down the Shift key, and click-

and-drag the upper-left control handle up to scale the layer until 

the flare center is just out of view. Press Enter when done. If the 

flare is too intense, simply lower the layer Opacity.

Step Eight: Now let’s enhance the color in the background. 

Make the Background layer active, then go to the Toolbox and 

choose the Sponge tool, which is grouped with the Dodge and 

Burn tools (O). In the Options Bar, set the Mode drop-down menu 

to Saturate and the Flow to 75%. Also, make sure Vibrance is 

checked on. Start painting the background area around the sub-

ject; the colors will become more vibrant—don’t overdo it though.

Step Nine: Going back to the 

light in the scene, we want to cre-

ate a light effect that looks like 

an atmospheric haze in the air. 

We’ll do this with a simple gradi-

ent. Start by creating a new blank 

layer at the top of the layer stack. 

Select the Gradient tool (G) in the 

Toolbox, and then in the Options 

Bar, click on the gradient preview, 

choose the Foreground to Trans-

parent preset in the Gradient Edi-

tor, and click OK. Next to the gra-

dient preview in the Options Bar, 

choose the Radial Gradient icon. Step Eight

Step Seven

Step Six
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Step Ten: Click on the Foreground color swatch near the bot-

tom of the Toolbox to access the Color Picker. We’re using a 

light-yellow color similar to the yellowish light in the scene. 

Click OK.

Step Eleven: With the Gradient tool, click in the upper-left 

area of the image near where you placed the flare center, and 

drag out a gradient to the lower-right area, as you see here. 

Change the layer blend mode to Screen to make the light seem 

more natural. 

Step Twelve: Now we’re going to create a bokeh effect 

from scratch using the Brush tool (B). Go to the Brush panel 

(Window>Brush) and choose a standard round brush. In the 

Brush Tip Shape section, set the brush Size to around 35 px, 

Hardness to 38%, and Spacing to 171%. 

Step Thirteen: Activate Shape Dynamics in the Brush panel. 

Set the Size Jitter all the way up to 100%, and push the Mini-

mum Diameter slider to around 50%. If you’re using a pressure-

sensitive tablet, then click on the Control drop-down menu just 

below Size Jitter and choose Pen Pressure. Step Thirteen

Step Eleven

Step Ten
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D O W N  A N D  D I R T Y  T R I C K S  › ›

Step Fourteen: Now activate Scattering. Check Both Axes on, 

and push the Scatter amount to around 625%. Again, select Pen 

Pressure if you’re using a tablet (but it’s not necessary). 

Step Fifteen: Activate Texture in the Brush panel. Click on the 

texture preview thumbnail at the top of the panel to open the 

Pattern Picker. Click on the gear icon at the top right, and select 

Patterns 2 in the drop-down menu. Click Append in the resulting 

dialog to add this set of patterns to the Pattern Picker. Locate the 

texture called Crystals (or any similar texture), and then tweak 

the settings, as shown here. You can see the changes take shape 

in the preview window below. Be sure to try different Modes 

with different textures, as they’ll behave differently. It’s worth 

experimenting with. In fact, that’s how I arrived at the settings 

I’m using here.

Step Sixteen: Finally, activate Transfer in the Brush panel and 

set both the Opacity Jitter and Flow Jitter to 100%. Now our 

bokeh brush is done. 

Step Seventeen: Create a new blank layer in the Layers panel 

at the top of the layer stack, and set its blend mode to Soft Light. 

Set the Foreground color to white by pressing D then X, then just 

start painting all around the subject to create a bokeh effect. It 

will have the appearance of small, reflected elements floating in 

the air. I even added a few in front of the subject. 

Step Eighteen: This bokeh effect is something that I use all the 

time now. If you think you’ll use this brush again and don’t want 

to re-create it every time you need it, then I suggest defining it as 

a tool preset. Simply click on the brush icon at the far left of the 

Options Bar to open the Tool Preset Picker, click on the Create 

New Tool Preset icon (just below the gear icon), name your tool 

preset, and click OK. This will save the brush, and all the settings 

applied to it, so it’s there and ready when you need it. You can 

even modify the settings and it won’t alter the original tool pre-

set. Pretty cool, huh? Enjoy! ■ Step Seventeen

Step Fifteen

Step Sixteen



http://www.topazlabs.com/mktg/psuser-lake.html
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Double-exposure effects have been getting more and more popu-
lar among designers and photographers lately. The posters for the 
movie Tomorrowland, which used this effect in a rather interesting 
and stylized way, inspired this particular technique. It involves some 
simple layer and blending techniques.

double-exposure effect
B Y  C O R E Y  B A R K E R
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Step One: As usual, this effect starts with a photo for the base 

subject. You want to find a subject that’s on a simple background 

so he or she will be easy to extract. While the background here 

has a vignette, it’s still simple enough for easy extraction.

[KelbyOne members may download the files used in this tuto-

rial at http://kelbyone.com/magazine/issue/september_2015. 

All files are for personal use only.]

Step Two: Choose the Quick Selection tool (W) in the Toolbox. 

Click-and-drag inside the subject until he’s entirely selected. If 

the selection creeps into the background, then just hold down 

the Option (PC: Alt) key and paint that area to remove it. 

Step Three: Click on the Refine 

Edge button in the Options Bar. 

Click on the brush icon in the 

Refine Edge dialog, and choose 

the Refine Radius Tool (E). Click 

on the View menu at the top 

and set it to either On Layers or 

On White, then paint around 

the edge of the subject’s hair. 

Step Four: Click on the View 

menu again and choose On 

Black. This will allow you to see 

any rough edges around the rest 

of the subject that you couldn’t 

see on the lighter or transpar-

ent background. Use the same 

Refine Radius Tool, but make 

the brush a little smaller by tap-

ping the Left Bracket key. Then, 

paint along the rough edges to 

smooth them out. 

Step Four

Step One

Step Two

Step Three
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Step Five: Switch the View to 

Black and White and you’ll be able 

to see any detail that might have 

been missed. The selected areas 

will be white; if you see some 

gray areas that you don’t want 

selected, then just raise the Con-

trast in the Refine Edge panel to 

clean up the edges. When done, 

set the Output menu to New Layer 

with Layer Mask and click OK.

Step Six: Create a new document (File>New) measuring 

600x900 pixels at 72 ppi. This will be the document in which 

we’ll create the design. 

Step Seven: Switch to the Move tool (V), 

and drag-and-drop the extracted subject 

into this new file. Press Command-T (PC: 

Ctrl-T) for Free Transform, hold the Shift 

key, and scale the subject so it’s more of 

a close-up, as you see here. Press Enter 

when done.

Step Eight: Open a city image. Here we have a cool skyline 

image of Shanghai. It has a very futuristic look that works for 

this concept. You can use this image, which is part of the exer-

cise downloads for KelbyOne members, or experiment with your 

own. We’re going to blend this with the subject.

Step Nine: Drag-and-drop this image into the main design file. 

It should appear on its own layer above the subject. Drop the 

layer Opacity to 50% so you can see the subject below. Enter 

Free Transform and scale and position the city where you want it 

in relation to the subject. Once you have it set, raise the Opacity 

back to 100%, and then drag the city layer below the subject 

layer in the Layers panel.

Step Ten: We need to mask 

the city using the shape of the 

subject. In fact, we’ll just copy 

the existing layer mask to this 

layer by holding down the 

Option (PC: Alt) key, and then 

clicking-and-dragging the layer 

mask from the subject layer to 

the city layer. This will copy-

and-paste the layer mask in a 

single step. Both the subject 

and the city should now have 

the same layer mask. 

Step Five

Step Eight

Step Nine
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› › D O W N  A N D  D I R T Y  T R I C K S

Step Eleven: In the Layers panel, click the layer mask thumbnail 

on the subject layer to make it active. Then, choose the Gradient 

tool (G) in the Toolbox. In the Options Bar, click the gradient pre-

view thumbnail, choose the Foreground to Transparent preset 

in the Gradient Editor, and click OK. Choose the Linear Gradi-

ent icon to the right of the gradient preview thumbnail in the 

Options Bar. Press D then X to set the Foreground color to black.

Step Twelve: Drag a gradient from the right edge of the image 

past the middle to reveal the city image layer below. Draw 

another gradient from the bottom to reveal the lower area of 

the city as well. Here you can start to see the effect taking shape. 

Step Thirteen: We want a more dramatic sky, so we’ll use one 

from another image. Here we have a stock image of a wheat field 

with a really cool sky, which is the only part we need. So grab the 

Rectangular Marquee tool (M) and draw a selection around the 

left side of the sky. Drag-and-drop this on the main document. 

Step Fourteen: Position this layer below the city layer and just 

above the Background layer in the Layers panel. Scale and posi-

tion the sky so that it best fits in the composition. Then, copy the 

subject layer mask to this layer the same way we did in Step Ten. 

Step Fifteen: In the Layers panel, click the layer mask on the 

city layer to make it active. Use the Gradient tool with the same 

gradient as before, but this time change it to a Radial Gradient 

in the Options Bar, and then add a few gradients around the top 

and back of the head to reveal the sky image in the layer below. 

Step Sixteen: Next, we’re going to add a color effect to the 

image. Click the Create a New Layer icon at the bottom of the 

Layers panel and drag it to the top of the layer stack. Click on 

the Foreground color swatch near the bottom of the Toolbox to 

open the Color Picker. Set the RGB numbers to what we have 

here—R:253, G:179, and B:103. Click OK.

Step Seventeen: Click on the Background color swatch and set 

the numbers to R:41, G:46, and B:79. Click OK.

Step Twelve

Step Thirteen

Step Seventeen

Step Fourteen Step Fifteen
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D O W N  A N D  D I R T Y  T R I C K S  › ›

Step Eighteen: Select the Gradient tool and then in the Options 

Bar, click on the preview thumbnail and choose the Foreground 

to Background preset in the Gradient Editor. Then, choose the 

Linear Gradient type again to the right in the Options Bar. 

Step Nineteen: Make sure 

the blank layer at the top is 

active, hold down the Com-

mand (PC: Ctrl) key, and click 

on the layer mask of the sky 

layer to load the full shape 

of the subject as a selection. 

Then, just draw the gradi-

ent from the left edge of the 

canvas to the right edge. The 

gradient should only appear 

inside the selected area. 

Change the layer blend mode 

to Overlay. Press Command-D  

(PC: Ctrl-D) to deselect.

Step Twenty: While this adds a nice color effect, we’re going to 

add a little more to it via a layer style. Make the cityscape layer 

active, then click on the Add a Layer Style icon (ƒx) at the bottom 

of the Layers panel, and choose Gradient Overlay. Click on the 

preview thumbnail and choose the Violet, Orange preset, which 

is the fifth one over. Set the blend mode to Hard Light and the 

Opacity to 75%. Click OK.

Step Twenty-One: As a final 

touch, create a new layer at 

the top of the layer stack, and 

then use a simple Foreground 

to Transparent Radial Gradi-

ent with the Foreground color 

set to white to add a subtle 

light burst right at the neck-

line on the left side of the sub-

ject. Drop in some text and 

there you have it. ■ 

Final

Step Nineteen

Step Twenty
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Sometimes you start out trying to achieve one type of look but you end 
up with a different, yet cool result. When using layer styles, a couple of 
minor tweaks to the settings can really change the final outcome; so 
don’t be afraid to play. Here’s a great way to create a base look that can 
lead you in multiple directions.

tingling skin 
B Y  P E T E  C O L L I N S
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Step One: Start with an image of a person. This is a tricky one: 

You want a cool image that shows a decent amount of skin for 

this technique, but that can get you into some interesting situa-

tions, so consider your audience when choosing.

[KelbyOne members may download the file used in this tuto-

rial at http://kelbyone.com/magazine/issue/september_2015. 

All files are for personal use only.]

Step Two: We need to cut out the eyes and put them on their 

own layer, so use the Lasso tool (L) to select one of the eyes, hold 

the Shift key, and select the other eye. Press Shift-Command-J 

(PC: Shift-Ctrl-J) to cut the eyes to their own layer. Double-click 

the name of this new layer in the Layers panel, and rename it 

“eyes.” Click the Create a New Layer icon at the bottom of the 

Layers panel to create a new blank layer above the eyes layer. 

Step Three: Use the Elliptical Marquee tool (nested under the 

Rectangular Marquee tool [M]) and draw a circular selection that 

encompasses one of the pupils. Hold the Shift key and draw a 

circular selection over the other pupil. Tip: Press-and-hold the 

Spacebar while drawing a selection to reposition the selection. 

Click the Foreground color swatch near the bottom of the Tool-

box, select a bright yellow color in the Color Picker, and click OK. 

Press Option-Delete (PC: Alt-Backspace) to fill the selection with 

yellow. Press Command-D (PC: Ctrl-D) to deselect.

Step Four: Double-click on the layer thumbnail of the yellow 

circle layer to open the Layer Style dialog. One of the least-used 

styles that can really make a difference is Satin. Click on Satin 

in the list of Styles on the left side of the Layer Style dialog to 

activate it and access its settings. Use the settings shown here. 

To change the Contour, click on the down-facing arrow to the 

right of the Contour thumbnail, and then select Rolling Slope – 

Descending. This will give you more life and depth to the pupil.

Step Five: You’ll also probably want to add an Inner Shadow 

while you’re in the Layer Style dialog. Make the shadow appear 

in the upper left to help it look like it’s interacting with the eyelids 

and brow. You can click-and-drag in the image to reposition the 

shadow. Click OK when done to apply the layer styles.

Step Six: On a new layer, switch to the Brush tool (B) and press D 

 to set your Foreground color to black. Click on the brush preview 

thumbnail in the Options Bar, choose a round brush, and set the 

Hardness to 100%. Place your cursor over one of the pupils and 

use the Bracket keys on your keyboard to change the size of your 

brush to the size you want her irises to be. Click once on each 

eye to paint in the irises. Hold the Option (PC: Alt) key and click 

between the eyes layer and the yellow circle layer to create a 

clipping group. This means the yellow circles only affect the layer 

beneath it (the eyes layer) and not any other layers.

Step Four

Step Five

Step One

Step Three

Step Six
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Step Seven: As a final touch, run the Blur tool around the outer 

edges of the pupil and iris layers so that they match the sharp-

ness of the rest of the face and don’t look quite so fake. Once 

the eyes look right, select all of the layers that make up the eyes 

in the Layers panel, Right-click on one of the selected layers, and 

select Convert to Smart Object to keep them together in one 

layer. Rename this layer “eyes” again.

Step Eight: Make the Background layer active and rip that skin 

right off. Use the Quick Selection tool (W), the Lasso tool (L), or 

the Pen tool (P) to create a good selection, and then copy it to 

a new layer using Command-J (PC: Ctrl-J). For this image, the 

Quick Selection tool works really well. If it selects too much, just 

hold the Option (PC: Alt) key and paint to remove those areas 

from the selection. What fun, peeling skin and removing eyes! 

The image here has the Background and eyes layers hidden so 

you can see what was selected and copied.

Step Nine: Now that you have a 

copy of the skin on its own layer, 

let’s change it to a beautiful blue. 

Click on the Create New Adjust-

ment Layer icon (half-white, half-

black circle) at the bottom of the 

Layers panel and choose Hue/Sat-

uration. Clip it to the skin layer by 

clicking the first little icon at the 

bottom of the Properties panel. 

Click on Colorize and apply the 

settings shown here.

Step Ten: Put the skin layer and the Hue/Saturation adjustment 

layer into a layer group by highlighting them both in the Layers 

panel and clicking the Create a New Group icon (folder) at the 

bottom of the panel. Name this group “blue face.” Press Com-

mand-J (PC: Ctrl-J) to make a copy of the layer group. Go into 

the top layer group and double-click on the Hue/Saturation layer 

thumbnail to open its settings in the Properties panel. Lighten the 

top skin layer a bit by adjusting the Lightness. Try a setting of 

around –40. Rename the skin layer in this group to “mask.” The 

image here shows both the top and bottom layer groups.

Step Eleven: This is where the magic happens. You want to give 

the top skin layer texture and depth so when you apply the layer 

mask in the next step it appears to be above the lower, darker 

skin. With the mask layer active, apply the Layer Style settings for 

Step Eight

Step Ten

Step Seven
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Bevel & Emboss, Contour, Texture, Satin, and Drop Shadow as 

shown here. For the Texture, click the Pattern thumbnail to open 

the Pattern Preset Picker, click the little gear icon at the top right 

of the Picker, and choose Artist Surfaces from the drop-down 

menu. Either append or replace the textures you have. The tex-

ture used here is called Parchment; it’s the tenth one in the Artist 

Surface’s series.

Step Twelve: Choose a black brush that’s around 10 pixels 

with a fairly high Hardness setting (the brush size will depend 

on the resolution of the image on which you’re working). With 

the top skin layer active, click the Add Layer Mask icon (circle in 

square) at the bottom of the Layers panel. Now every stroke of 

black you paint on the mask layer will hide part of the top layer 

of skin, and because of the layer styles it will look like you’re 

cutting away part of the skin. Use the laugh lines and contours 

of the face to help determine where the lines should be drawn. 

The great part of doing a front-on face is that you can focus on 

one side and then copy-and-flip the lines for the other side for 

better symmetry.

Step Thirteen: This is completely up to you, but removing 

whole squares of skin in a few areas adds a nice bit of con-

trast and detail. Remember, with this entire process happening 

on a mask layer, if you mess up, simply press X to switch to 

white, and brush away the mistakes. The layer styles are doing 

the heavy lifting and it’s pretty cool to paint away areas as if 

they’re real and have substance to them. Or maybe that’s just 

my inner Dexter.

Step Twelve

Step Thirteen

Step Eleven
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Step Fourteen: Use different sized brushes and strokes to add 

random patterns and marks to the skin. One favorite technique is 

to use a large circular brush to make a hole through the top skin 

layer and then switch to a smaller white brush to add back the 

center of the hole. Adding dots of descending or ascending size 

is easy: Just click once; press the Left Bracket or Right Bracket key 

to respectively decrease or increase the size of the next dot; and 

click to add the next dot. Have fun—you may end up creating 

several copies of this layer just to keep playing and figuring out 

new patterns and symbols.

Step Fifteen: Here’s a quick trick to add a little shadowing and 

contrast. Hold the Command (PC: Ctrl) key and click on one of 

the skin layer thumbnails to load the skin shape as a selection. 

Create a new layer at the top of the layer stack. Press Shift-Delete 

(PC: Shift-Backspace) to bring up the Fill dialog, choose 50% 

Gray from the Contents drop-down menu, and click OK.

Step Sixteen: Double-click on that layer to bring up the Layer 

Style dialog and apply a Gradient Overlay using the settings 

shown here. Click on the Gradient thumbnail to select the Black, 

White preset in the Gradient Editor, and make sure that both 

the Gradient Overlay and the actual layer in the Layers panel 

are set to the Overlay blend mode. This will cause the gray to 

disappear and just leave the gradient boosting the light and dark 

contrast across the figure. Deselect.

Step Seventeen: Now all you need to add is some smoke 

along with some funky type. This font is called BadaBoom BB, 

which can be found at www.Dafont.com in the Comic sec-

tion—go figure.

Hopefully, you now have a better appreciation for layer styles, 

especially Satin, and are filled with new creative ways to “skin a 

cat.” Ouch, yes I know that was terrible, but it’s all part of my  

charm and mystique. So get in there, play, and have some fun. ■ 

D O W N  A N D  D I R T Y  T R I C K S  › ›

Step Fourteen

Step Fifteen

Step Sixteen

http://www.dafont.com
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LESA SNIDER
Beginners' Workshop
 how to replace wall art

Step One: Open an interior room shot and zoom into your 
image by pressing Command-+ (PC: Ctrl-+) so you can better see 
the corners of the frame you’re about to select. Press-and-hold 
the Spacebar on your keyboard and drag with your mouse to 
reposition the image once you’re zoomed in. Your cursor turns 
into the tiny hand (circled here).

Step Two: Create a selection of the area into which you want to 
paste the new art. You can use any tool you want to make the 
selection; however, the Pen tool (P) works really well. Grab the 
Pen tool (circled) and in the Options Bar, choose Path from the 
drop-down menu at left.

Step Three: Click one corner to start your path, then mouse 
to another corner and click it. Photoshop puts a thin gray line 
between the two points. Click the other two corners and then 
close the path by clicking atop the starting point. (You’ll see a 
tiny circle appear beneath your cursor, as shown here.)

Step Four: If necessary, adjust the path so each point fits snugly 
into the corners. Grab the Direct Selection tool (nested under the 
Path Selection tool [A] in the Toolbox) and click somewhere else 
in your image to deselect the path (the corner points disappear 
but the gray outline remains). Zoom into your document a bit 
more and then click the point you want to adjust—it becomes 
solid but the rest of the corner points are see-through—and 
then drag the point to adjust its position. When you do, only the 
selected point moves. Adjust the other three points as necessary. 
Tip: If you need to scoot the whole path around, Command-click 
(PC: Ctrl-click) it so all four corner points become solid and then 
drag the path into the right position.

Step Five: When the path is just right, load it as a selection by 
pressing Command-Return (PC: Ctrl-Enter). Step Four

Step Two

Step One

Photoshop makes it easy to replace existing wall art, or an image shown on a digital screen, with whatever imagery 
you want. In this column, we’ll use the Pen tool to create a selection that you paste another image into, and then 
we’ll adjust the art’s perspective so it matches the frame. 

Step Three
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Step Six: Open the image you want to use for the new art 
and press Command-A (PC: Ctrl-A) to select it and then copy it 
into memory by pressing Command-C (PC: Ctrl-C). Switch back 
to the document in which you made the selection and choose 
Edit>Paste Special>Paste Into. The new art appears on its own 
layer, masked with your selection (the mask is circled here).

Step Seven: Summon 
Free Transform by press-
ing Command-T (PC: 
Ctrl-T). On the bound-
ing box that appears, 
Shift-drag any corner 
handle inward to resize 
the art so it’s a bit big-
ger than the frame. Tip: 
Press Command-0 (PC: 
Ctrl-0) to have Photo-
shop resize your document so you can see the corner handles. 
Next, Right-click inside the box and choose Distort from the 
resulting menu. Drag each corner handle inward toward the 
corners of the frame. The art’s perspective shifts as you drag 
each point, so you’ll need to adjust them individually to get it 
just right. Press Enter when you’re finished. Here’s the before 
image and the final result after swapping out three pieces of art.

Step Eight: If you’re placing art inside a frame that has depth, 
add an Inner Shadow. With the new artwork layer active, click 
the tiny ƒx icon at the bottom of your Layers panel. Choose 
Inner Shadow and then adjust the settings until the shadow 
looks realistic. You can click-and-drag inside the image to move 
the shadow into position. Click OK when done. As you can see 
in this before (left) and after (right) versions, an Inner Shadow 
adds realism.

If, after adding the Inner Shadow, you discover that some of 
the frame’s original contents are visible, simply adjust the layer 
mask’s size. Click the mask thumbnail in the Layers panel to acti-
vate it (you’ll see a tiny white border around it) and then press 
Command-T (PC: Ctrl-T). Drag to adjust the handles as needed 
and then press Enter when you’re finished. 

As you can see, it’s fun to swap out existing art in an interior shot. 
Until next time, may the creative force be with you all! ■ Step Eight
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KEVIN AMES
Dynamic Range
 linked smart objects

H O W  T O  › ›

EMBEDDED SMART OBJECTS
Embedded smart objects have been in Photoshop since CS2 

(a.k.a. version 9). You added smart object layers to the Layers 

panel by using the File>Place menu, or as a new document 

by opening a smart object from Camera Raw, which replaced 

the Background layer with a copy of the original RAW file 

from the camera. Embedded smart objects are independent 

of other versions of the same file; a change made to the origi-

nal file will not change the embedded smart object.

LINKED SMART OBJECTS
Linked smart objects entered the scene in Photoshop CC 2014 

(v14.2) with the addition of the File>Place Linked option. 

Linked smart objects can only be added using File>Place 

Linked in Photoshop; files opened as smart objects in Camera 

Raw or Lightroom are embedded only. Existing embedded 

smart objects can be changed to linked ones in the Properties 

panel in Photoshop. A smart object that’s been linked can be 

modified in the Develop module of Lightroom only if the link 

is to a file that has previously been imported into Lightroom.

EMBEDDED TO LINKED
Changing an embedded RAW smart object to a linked one  

is easy.

Step One: Let’s start by creating the embedded RAW smart 

object. Navigate to a RAW file in Bridge, and highlight it. 

Press Command-R (PC: Ctrl-R) to open it in Camera Raw. 

Hold down the Shift key to change the Open Image button 

to Open Object, and click to send it to Photoshop. It opens 

as an embedded smart object.

Step Two: Highlight the embedded smart object layer in the 

Layers panel. The Properties panel (Window>Properties) rec-

ognizes that a smart object is active.

Updating multiple Photoshop files that use common elements used to be a major pain. Each element had to be 
refreshed individually in every file. Not anymore. Enter the world of linked smart objects. Linked smart objects are 
the key to updating changes to a Photoshop master file to several target files by doing nothing more than opening 
them. It’s that simple. Really.

Step Three: Click the Convert to Linked button. A Save 

dialog opens prompting for a location to save the linked 

smart object. The Save As field displays the embedded smart 

object’s name without an extension. For this to work with an 

existing RAW file, it must have the extension that tells what 

type of RAW file it is, so add the appropriate extension (.cr2 in 

this example) to the name. The destination folder should be 

where the original RAW file is located. Click Save, and when 

asked if it’s okay to replace the file, click Replace. It over-

writes the RAW file but not it’s corresponding XMP sidecar 

file. (See “Cautions”on page 52.) 
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› › D Y N A M I C  R A N G E

Step Four: Now, whenever you make a change to the origi-

nal RAW file, it will be reflected in the linked smart object in 

Photoshop. There will be some lag time as the original file 

communicates with the linked smart object layer in Photo-

shop. When you open a file that has a linked smart object 

that’s been modified, you may need to force Photoshop to 

update it. Click the Edit Contents button in the Properties 

panel. The original smart object opens in Camera Raw. Click 

OK. The linked smart object layer updates to the changes. This 

screenshot shows the original smart object in Bridge over the 

linked one in Photoshop. When the update completes, the 

Photoshop content will reflect the version shown in Bridge.

Step Five: Let’s test it out. With the linked smart object file 

that you created in Steps One through Three still open in 

Photoshop, use Bridge to navigate to the place you saved 

the linked smart object from Step Three. Highlight that file, 

and press Command-R (PC: Ctrl-R) to open it in Camera Raw. 

Click the HSL / Grayscale tab, and click the Convert to Gray-

scale box. Click Done. Go back to Photoshop. An update will 

begin indicated by the rotating “wait” icon. When it’s fin-

ished, the photograph turns to black and white.

The original smart object can be linked in as many differ-

ent Photoshop files as you want. Modify that original smart 

object and your changes propagate to the Photoshop files as 

they’re updated.

ANY SMART OBJECT CAN LINK
The ability to change a RAW file in Camera Raw and have 

Photoshop files update automatically is exciting and a big 

time saver. Linked smart objects work with text and pixel 

layers, too. Recently, I went through an identity mini-crisis.  

I started rebranding Ames Photographic Illustration to pho-

tography by kevin ames (the lowercase is intentional). I pro-

duced a couple of sell sheets with my logo and new brand. 

Fortunately, I made them with linked smart objects (notice 

the little link icon in the upper-right corner of the thumbnails 

in Bridge). Fortunate, indeed, because I wound up changing 

not only the word mark but every one of the photos, as well.
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After the realization that branding my name is more impor-

tant than the word “photography,” I finalized the brand as 

kevin ames photography. (Website and Facebook business 

page were the same—many thanks to ASMP member Chris 

Bloor for this.) This meant I had to change (gulp) everything. 

Here we go:

Step One: My logo and text layer with the old wording were 

already in a smart object. Double-clicking this file in Bridge 

will open it in Photoshop. There’s only one layer in the stack, 

and it has a smart object icon on the layer thumbnail. This is 

the original smart object that’s linked to the other files.

Step Two: Double-

clicking the smart 

object icon opens it 

for editing. Using the 

Move tool (V) with 

the Option (PC: Alt) 

key held down, drag 

the highlighted text 

layer up to duplicate 

it. Hide the lower text layer by clicking its Eye icon in the Layers 

panel. Double-click the layer thumbnail of the duplicated text 

layer to highlight the text and switch to the Type tool (T). Edit 

the text, and accept the changes by clicking the checkmark 

icon in the Options Bar. Move the new text into position using 

the Move tool.

Step Three: Choose File>Save then File>Close. The smart 

object returns to its single layer state shown in the graphic 

for Step One. Save it then close it using the same commands. 

Step Four: Back in Bridge, the logo in the sell sheets is as it 

was before. Highlight all the files that use the linked smart 

object that you just updated, then double-click to open them 

in Photoshop. Sometimes the files will update automatically 

upon opening; if they don’t, then follow the next step.

Step Five: Check the layer stack of one of the should-have-

but-didn’t-update images. There will be a yellow warning 

sign on the linked smart object. Click the warning sign in 

the Properties panel, then choose Update Modified Con-

tent. Don’t be surprised if the other open files update. If they 

don’t, you know what to do.



› › D Y N A M I C  R A N G E

› 
› 

k
e

l
b

y
o

n
e

.c
o

m

051

QUICK-CHANGE ARTIST
Normally, when creating a layout in Photoshop, each photo 

is retouched and enhanced before dropping it into the lay-

out as a layer. It would then be resized to fit the placeholder. 

Every subsequent change required the same work. When 

you use smart objects linked to the original, all of that labor 

is eliminated.

Step One: Select photos for your layout and place them as 

linked smart objects before doing any postproduction work 

to them. 

Step Two: Retouch the original of each photo in the  

layout. Here are the changes I made to my originals. I noticed 

there was a hair crossing the eye of the curly haired model, 

and the photo seemed a bit flat. I fixed the exposure and 

then did the retouching using the Spot Removal Brush (B) 

set to Heal in Camera Raw (also available in Lightroom).  

Visit https://vimeo.com/100588139 for a short video on  

that retouch.

The beauty portrait of the blue-eyed model got a high-key 

makeover to whiten her skin, and brighten and saturate her 

eye color.

The backlit model pushing her hand through the sheers 

went through several versions.

Step Three: Once all of the retouching and finishing is com-

plete, save the original smart objects. 

http://vimeo.com/100588139
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Step Four: Open the sell sheets. They may or may not update 

on their own. If they don’t, you’ll see the yellow warning 

triangle with an exclamation point in it in the Layers panel. 

Highlight each layer with the warning in turn, go to the 

Properties panel, click the warning symbol, and then choose 

Update Modified Content.

MORE ON LINKING SMART OBJECTS
Photographers aren’t as familiar with linking as, say, design-

ers who work with Illustrator and InDesign. Linking is a way 

to vastly improve a workflow where changes are a constant. 

Clients who micromanage results are a fact of life. These 

entrepreneurs are in a constant do-it-review-it-update-it-

review-it-again-repeat process and can be an extraordinary 

time-intensive drain on the person tasked with keeping the 

changes flowing. Linked smart objects allow changes to be 

made in an almost automated way, especially when com-

bined with layer comps. File>Scripts>Layer Comps to Files 

provides a way to quickly create new versions. 

CAUTIONS
Linked smart objects work well. It’s important to create a 

folder structure that clearly says, “These are smart objects 

that are linked to other files.” This is the reason I prefer to 

work with copies of RAW files rather than linking to ones 

in my Lightroom Library. Imagine what chaos might ensue 

if a linked file in Lightroom is converted to black-and-white 

and it links to a full color file headed out to be made into an 

expensive metallic wall-sized print. Ouch!

ONE MORE CHANGE
I like the excitement of the model with my brand above her 

hands. I wonder how it would look if her dress were red 

instead of black. Could a linked smart object do this easily? 

Why, yes it can. Next issue, I’ll show you how right here in 

“Dynamic Range.” ■  

ALL IMAGES BY KEVIN AMES
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Bar, I held Shift and clicked on the left and top edges of the 

larger quad. You can see them selected in yellow below. Doing 

so snaps the selected edge either vertical or horizontal, depend-

ing on which axis is closest. This is very handy when you want to 

straighten an architectural feature!

Okay, with the two edges highlighted, I can now drag just 

the top left pin down and to the right until that quad is about 

the same size as the 10x10 quad. Notice the distortion around 

the quads—some of the lines are bent and even a little curved.

Now let’s back up a little by returning to Layout mode (L), 

and add a third quad between these two, letting the edges weld 

together. Choose an area between the current quads and click-

Most of the demos you’re likely to see online cover basic correc-

tions or changes to buildings and structures; but can we apply 

this tool to something more organic, like a portrait? Absolutely! 

Before we get there, let’s get an objective view of how Perspec-

tive Warp works. (Note: For more on the Perspective Warp tool, 

see Episode 394 of Photoshop User TV at http://bit.ly/1FkCizg.)

[For the Fotolia stock images used in this tutorial, go to  

www.fotolia.com and use the discount code 353BN3GF. For 

the graph paper, search for 70033294, and for the portrait, 

search for 51790563. The discount code is good for five free 

images within a 12-month period. We’d like to thank Scott Val-

entine and Fotolia for arranging this special offer for our readers.]

Getting Graphic
Of course we’re going to start off with an experiment. In this 

case, the simple graph paper image from Fotolia works. First, 

make a copy of your layer (Command-J [PC: Ctrl-J]), and then go 

to Edit>Perspective Warp and drag around the area you want to 

affect. In the first image, I’ve created two separate planes (called 

“quads”) that aren’t connected. One really cool feature of Per-

spective Warp is that you can add multiple quads independently, 

or have them connected. I laid out the quads as close to inter-

secting corners as I could. One quad is 10x10 squares, the other 

is 15x15 squares. The goal is to make them roughly the same size 

and see what happens to the various regions of our graph paper. 

Tip: For more precise placement of pins, use Guides and turn on 

Snapping with View>Snap To>Guides.

Since I’m already dealing with straight lines, I cheated a bit. 

After moving from Layout mode (placing the quads) to Warp 

mode (warping the image by moving the pins) in the Options 

SCOTT VALENTINE
Photoshop Proving Ground
 taking perspective warp beyond the expected
Perspective Warp got a lot of attention when it first showed up in Photoshop CC, and it made a lot of photo
graphers very happy. It’s incredibly easy to use, and gives some outstanding results on even some really large 
perspective changes. Some of this could be done with the Transform tools, but Perspective Warp adds the ability 
to define perspective planes for added flexibility and control.

K E Y  C O N C E P T S  › › Clone Stamp tool
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http://kelbytv.com/photoshopusertv/2014/10/16/photoshopuser-tv-perspective-warp-and-new-flame-tool-in-photoshop-episode-394/
https://us.fotolia.com
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and-drag to start a new one. When you drag the pin of the new 

quad close to another pin, the edges will turn blue to indicate 

they’ll be mated. Make sure to weld (mate) both vertical edges 

of the new quad to the previous ones. Note: After you draw your 

quad, you can drag the individual corners into position while still 

in Layout mode.

Switch back to Warp mode (W or Enter) and repeat the exper-

iment. This time, the lines between the two original quads aren’t 

distorted, just angled. The lines outside the quads are still free 

to distort. Notice also that not all of the lines meet up perfectly. 

Anywhere there’s a quad edge, you run the risk of creating a 

seam or tear when you introduce too much distortion. Some-

times you can fix this with healing tools; other times, it’s best just 

to be more delicate in your adjustments.

Putting It into Practice
This shot of a seagull under the Monterey Bay pier is an easy 

fix with Perspective Warp. I want to maintain the strong angle 

from the deck on the right of the image, but straighten the 

piling behind the gull. I’ve placed a guide for better visual 

placement of where I want the piling’s edge to end up. I then 

added quads to approximate three sides of a cube, which 

more or less defines the 

starting perspective. 

After just a few pin 

moves, I’m left with a 

straightened image and a 

little Clone Stamp tool (or 

cropping) work to fill in 

the areas where the photo 

was pulled into the canvas 

area. Tip: Notice that the 

edges of the quads are 

outside the canvas area! 

This helps reduce the odd 

distortions we saw in the 

graph paper.

In general use, you’ll 

want to place the quads so 

that the grid they present 

roughly matches the per-

spective of the object you 

want to move or isolate. For buildings, some vehicles, and other 

relatively blocky objects, this isn’t too difficult. But what about a 

human face? If you’ve studied artistic anatomy, you know that 

the face is made up of several planes. Fortunately, Perspective 

Warp lets us approximate more than simple boxes.

Warping Portraits
Let’s say I want to adjust the balance of this model’s face, simu-

lating a slightly longer lens, and just a touch different tilt. Doing 

this with the Liquify filter could be a serious nightmare. Let’s try 

Perspective Warp (you knew I was going to say that, didn’t you?).

I’ve laid out six quads that approximate some of the impor-

tant planes of her head. They don’t have to be perfect, but try to 

hit major landmarks to make things smoother and a little easier 

on yourself. Don’t forget to let the edges mate so everything 

works together.

› › P H O T O S H O P  P R O V I N G  G R O U N D
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In this case, I’m going to let her hair and body move freely 

when I adjust the quads. This sometimes results in a need to crop 

or otherwise fill areas where the edge of the layer becomes vis-

ible on the canvas.

It’s very easy to go overboard with this tool, so exercise some 

care and keep track of the overall effect as you work. Some of 

the features will be changed, but the effect can still be natu-

ral if you take your time and stay alert. I simply brought in the 

left quads a little and refined the others to maintain her overall 

shape. The planes I set on the right side of the photo act to pin 

those areas in place so they don’t get distorted.

The end result is pretty good, if I do say so myself. Her face 

is more flat toward the camera, and her forehead isn’t quite so 

pronounced. I finished the transformation with a little Liquify 

on the left side of her face to smooth out her jaw and move 

her ear up. By taking time to draw quads that are similar to the 

planes of her face, I’m free to play with alignment of her eyes, 

nose, and jaw as I see fit.

We’d love to see what other ways you can use Perspec-

tive Warp. Please share them on KelbyOne’s Facebook page 

(www.facebook.com/KelbyOneOnline)! ■ 

I should finish with a few tips to help you along.

• �Ensure you’ve enabled the graphics processor in 
your Performance Preferences in Photoshop.

• �You can use the Arrow keys on your keyboard to 
nudge a selected pin in small increments. (Don’t for-
get you can snap pins to guides!)

• �You can drag the edges of a quad in Layout mode, 
but not in Warp mode. Holding Shift while dragging 
an edge stretches the quad in perspective.

• �Once you let two quads snap together, you can’t 
separate them. You have to click inside one of the 
quads to select it, press Delete (PC: Backspace) to 
remove it, and then replace it. If you get too close, 
the edges will snap again—there’s no way to over-
lap quads in Layout mode.

• �Be careful with complex or dramatic changes; it’s 
easy to get bizarre distortions by dragging pins too 
far or trying to twist quads around each other.

• �You can first convert your layer to a smart object 
(Layer>Smart Objects>Convert to Smart Object) to 
keep the entire process nondestructive. This has 
the added bonus of letting you see your before and 
after quads!

A FEW TIPS FOR BETTER WARPING

https://www.facebook.com/KelbyOneOnline
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H O W  T O  › ›

Ever wonder what your house might look like if you painted it or otherwise changed its color? Photoshop is great 
for performing what-if scenarios to simulate how objects in the real world might look if they were colored or 
textured differently. We’ll paint my house virtually in this tutorial.

Beyond Photoshop
 painting your house with photoshop

SCOTT ONSTOTT

Step One: Open House.jpg and select the Polygonal Lasso 

tool (nested under the Lasso tool [L] in the Toolbox). Press the 

Caps Lock key to use the precise cursor. Click points around the 

perimeter of the left face of the building and try to select the 

siding only without the trim. Don’t worry about the windows or 

chimney yet. Click on your starting point to create the selection.

[KelbyOne members may download the file used in this tuto-

rial at http://kelbyone.com/magazine/issue/september_2015. 

All files are for personal use only.]

Step Two: Click the Subtract from Selection icon (darker square 

overlapping lighter square) in the Options Bar and click points 

around the chimney and the five windows on this side of the 

structure, taking care to subtract the window trim as well. This 

is analogous to the masking work you’d have to do on a scaffold 

in preparation for painting. So that the edge of the paint mask is 

softened, choose Select>Modify>Expand, enter 2 pixels, and click 

OK. Choose Select>Modify>Feather, enter 1 pixel, and click OK.

Step Three: Double-click the Background layer in the Layers 

panel to unlock it. Accept the default name Layer 0 and click 

OK. Choose Layer>New>Layer Via Cut to transfer the selection 

to Layer 1. Toggle off Layer 0 by clicking its Eye icon, and choose 

Image>Adjustments>Desaturate. We’re stripping color informa-

tion out of the texture so we can paint or stain it ourselves, and 

get rid of the moss growing in the lower-right corner as part of 

the bargain.

Step Four: Toggle Layer 0 back on and double-click Layer 1 just 

to the right of its name—this is a shortcut that opens the Layer 

Style dialog. Click the words Color Overlay in the list of Styles 

on the left to toggle this effect on and simultaneously go to its 

property page. Decrease Opacity to 75% so that the shadows 

from the horizontal siding start to become visible through the 

solid color. (Note: The default color in my Color Overlay style is 

fire-engine red; your default color may be different.)

Step Five: Fire-engine red isn’t my first choice, so while the Layer 

Style dialog is still open, click the color swatch and vary the color 

in the Color Picker. To make the application of color look more 

like wood stain rather than paint, try changing the Blend Mode 
Step Four

Step Two

Step Three

http://kelbyone.com/magazine/
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Step Nine

Step Five

Step Six

Step Seven

Step Eight

to Overlay in the Layer Style dialog. Experiment with color, Blend 

Mode, and Opacity of the Color Overlay until you’re satisfied.

Step Six: If you decided on more of an opaque paint rather than 

a stain by selecting the Normal Blend Mode in Color Overlay, 

the shading is too flat because the paint is obscuring the natural 

shadows. To compensate, apply a Gradient Overlay in the Layer 

Style dialog. Click the Gradient thumbnail preview and select the 

Black, White preset in the Gradient Editor, and click OK to close 

the Gradient Editor. Set the Angle down to the left to simulate 

a shadow under the eaves. Change the Blend Mode to Overlay, 

Opacity to 69%, Scale at 81%, and drag the gradient onscreen to 

suit your preference. (Note: If you can’t drag the Gradient Over-

lay onscreen, try clicking the Reset Alignment button first.) The 

Gradient Overlay helps break up flat surfaces with tonal variation.

Step Seven: To remove the bright halo around the paint, click 

Stroke in the Layer Style dialog. Click the color swatch and then 

click on the colorized wall to sample one of its hues. Click OK 

to close the Color Picker. Set the Position drop-down menu to 

Outside and the Blend Mode to Overlay. Click in the Size field and 

press the Up and Down Arrow keys to vary the amount. Watch 

onscreen as you change the size to find what looks best. I settled 

on a 2-px stroke.

Step Eight: The water staining halfway up the dormer’s side 

surface comes from rain splashing off the roof onto the wall. For-

tunately, we don’t have to get up on the roof with a pressure 

washer when Content-Aware Fill will do the job virtually for us. 

Select Layer 0 and the (regular) Lasso tool, and draw a selection 

around the water staining. Choose Edit>Fill and select Content-

Aware from the Contents drop-down menu. Click OK and press 

Command-D (PC: Ctrl-D) to deselect.

Step Nine: Repeat Steps One through Seven on this surface and 

then again on the right surface and entryway of the house. To 

save time, Option-drag (PC: Alt-drag) the layer effects from one 

layer to another and all your configurations in the Layer Style 

dialog will be copied. Then you can double-click the layer styles 

in the Layers panel to open the Layer Style dialog and customize 

the properties on each individual surface from the point where 

you left off the previous surface.

In the end you’ll have answered the question, “What would the 

house look like if we painted it?” Many such impressions are 

possible and it takes far less time and money to explore these 

questions in Photoshop than actually painting the house—or 

your bike, car, or apartment’s interior—a color you’re not going 

to enjoy in the long run. [For more on redecorating an interior 

with Photoshop, see page 62.—Ed.] ■ 

ALL IMAGES BY SCOTT ONSTOTT
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D E PA R T M E N T  › ›

Photoshop Tips
  boost your productivity and creativity

In this installment of “Photoshop Tips,” I’ve included a number 

of my favorite tips, many of which deal with layers. It’s really 

worth trying these out for yourself; you’ll be happy you did. 

New Document from Selected Layers
This is a great tip for people who use PSDs as templates and like 

to take a fork in the creative road to try different versions of a 

design. The challenge has been that the documents tend to get 

cluttered pretty quickly. Copying just the layers that you want to 

a new document, or deleting the ones that you don’t want, is a 

lot of work. Try this instead: Command-click (PC: Ctrl-click) to 

select just the layers that you’d like to keep in the Layers panel. 

Right-click one of the selected layers and select Duplicate Layers. 

In the resulting dialog, choose New in the Document drop-down 

menu under Destination. You can name it if you want to, but you 

don’t have to. Click OK and a new tab will open in Photoshop. 

It will be the same size as your working document, but only con-

tain the layers that you selected. Save it and carry on. How’s that 

for a clean slate?

Isolate Layers
When working in a multi-layered document, it doesn’t take long 

for the Layers panel to fill up, and you can spend a lot of time 

scrolling through the Layers panel searching for a particular layer. 

This can be frustrating when you’re working on layers that are 

far apart in the Layers panel, and you may feel like you’re spend-

ing more time scrolling and searching than actually working. 

Wouldn’t it be great if there were a quick way to hide the other 

layers in the panel, and only show the ones that you’re working 

on? We still want them visible in the document; we just want to 

hide them in the Layers panel. Of course, there’s a quick way to 

do this: Command-click (PC: Ctrl-click) to select the layers that 

you want to work with in the Layers panel. With the Move tool (V)  

active, Right-click in the document (not the Layers panel), and 

select Isolate Layers. All the non-selected layers will be hidden 

in the Layers panel. When finished, Right-click in the document 

and choose Isolate Layers again to return things back to normal. 

Automating Your Layer Selections 
When you have the Move tool (V) active, you’ll see an Auto-

Select checkbox toward the right side of the Options Bar. 

If you turn on this option, Photoshop will work like Illustra-

tor when selecting layers. Just click on any object and that 

layer will become the active layer. This is great if you have 

a lot of non-overlapping layers and you need to reposition 

them quickly. If you turn on Show Transform Controls, you’ll 

get an added bonus: You can now tell which layer is active, 

because it will be surrounded by transform handles that 

you can use to resize and 

rotate the layer.

COLIN SMITH
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Between the two aforementioned checkboxes there’s a drop-

down menu that offers two options: Layer or Group. This enables 

Auto-Select on either individual layers or layer groups. If you’re 

using this method of making layers active, and you can’t seem to 

select individual layers, make sure this drop-down menu is set to 

Layer and not Group. (Bonus Tip: With the Move tool active, but 

Auto-Select turned off, you can hold the Command [PC: Ctrl] key 

and click an object to make that layer active.)

Artboard Select
Have you tried using the new artboard feature in Photoshop CC 

2015 yet? It’s a great way to build multiple versions of a design. 

Once you have objects on layers in the artboards in your docu-

ment, you can press Shift-V to toggle between the Artboard tool 

and the Move tool, or try this: In the document window, Com-

mand-click (PC: Ctrl-click) on an object inside one of the art-

boards to switch to the Move tool. This makes that layer active 

so you can reposition that element. To manipulate the size and 

position of the artboards, as well as create new ones, click on an 

artboard’s name on the canvas to change to the Artboard tool 

with all its functionality and ability. 

Smooth out Gradients 
There are certain times when you apply a gradient and it doesn’t 

look as smooth as it should and you can see banding: visible 

stripes where there’s a transition in color. Here’s a way to smooth 

it out. First, add some noise by going to Filter>Noise>Add Noise; 

add a very small amount in Monochromatic. Now, choose 

Filter>Blur>Gaussian Blur, and set the Radius high enough to 

blur the noise you added. The result should be a smoother- 

looking gradient. 

Moving Points During Path Creation
Over the years, Photoshop has improved so that it’s become 

easier to create paths with the Pen tool (P). Paths are powerful 

because they enable you to create the cleanest possible selec-

tions and paths for extracting objects from photos. Once you 

start using the Pen tool on a regular basis, you’ll find that you 

need to move points as you’re creating the path. To do this, 

as soon as you click to add a point, and before you release the 

mouse button, press-and-hold the Spacebar and drag the point 

to a different position. Once you release the mouse button the 

Spacebar will no longer work. You’ll have to use the Command 

(PC: Ctrl) key instead.

Nested Animations and Video in Photoshop
When you’re creating animations in Photoshop, here’s a way to 

help you build complex animations while keeping the Timeline 

clutter to a minimum. One of the things I learned from using 

Flash is to create a nested symbol, or a pre-comp in After Effects. 

This stacks all the layers into a “container,” so the layers can 

be manipulated together, but still provides access to individual 

layers if needed. You can get a similar result in Photoshop by 

Command-clicking (PC: Ctrl-clicking) to select the layers that 

should be included in the animation, Right-clicking one of the 

selected layers, and choosing Convert to Smart Object. You can 

access the layers by double-clicking the smart object in the Layers 

panel to open it. 

Clipped Adjustment Layer
Adjustment layers are great when it comes to changing things 

such as the color or the tone of your photographs. By default, 

they’ll affect all the layers below the adjustment layer. This works 

well for most situations; however, there may be times when you 

have some transparency on a layer (usually in a composite), and 

you only want the adjustment layer to affect this layer, and not 

any of the layers below it. In frustration, you may be tempted to 

apply a destructive adjustment directly to the layer. Don’t do it! 

Instead, try this: Create an adjustment layer and click the little 

square with a bent arrow at the bottom of the Properties panel 

to clip the adjustment layer to the layer directly beneath it. Now 

only that layer will be affected, and none of the layers under-

neath. Alternatively, place your cursor on the line between the 

adjustment layer and the layer below it; hold down the Option 

(PC: Alt) key—you should see a similar square with a bent-arrow 

symbol appear—and click to clip the Adjustment layer. Do the 

same thing again to unclip the layer. ■



Redecorating a room can be a hassle and often leads to disagreements in the household. Not 

everyone has the ability to visualize how changes will look, so even if you’re that creative person 

who can, you’ll still probably have to communicate your ideas with your spouse, painter, or sales-

person. What if you could save time, money, and frustration by pre-visualizing how the room will 

look even before you buy a single piece of furniture or can of paint? With Photoshop and a little 

work, you can turn a picture into your own designer template to try out any color or furniture 

combination—without ever having to describe a color or move that dang couch.
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Take the picture at eye level and stay parallel to the back wall

    Room for 

Change
BY PETE COLLINS

Step One: Photograph the room
If you have a tripod, this would be a good 
time to use it. Use a smaller aperture to 
keep everything in the room in focus (f/8 
or higher would be good). To make your 
life easier, take your shot from eye level 
with a fairly wide-angle lens. A 24mm lens 
or wider is a good choice, but make sure 
the sensor (back of the camera) is parallel 
with the back wall so that you won’t have 
to work with weird angles. An exception 
to this is if the image of the couch that 
you want to use is only available from a 
certain angle, then you’ll want to shoot 
the room from that same angle so it’s eas-
ier to work with the couch in Photoshop (more on that below).

Remove any items in the room that you can take out easily to make it less time-consuming when working in  
Photoshop. Plants and pictures can be easily cloned out if they have enough wall around them to sample, but it may 
be faster just to pull them out of the room for a couple of shots, depending on your cloning- and healing-skill level.

[KelbyOne members may download the room image and red couch used in this tutorial at http://kelbyone.com/ 

magazine/issue/september_2015. All files are for personal use only.]

› 
› 

p
h

o
t

o
s

h
o

p
 u

s
e

r
 ›

 s
e

p
t

e
m

b
e

r
 2

0
15

062

http://kelbyone.com/magazine/
http://kelbyone.com/magazine/


Spot Healing out the easy parts of the plant and the lamp

Make sure Color  
Adaptation is checked

Lasso and Content-Aware Fill the plant

Repeat with the couch

Step Two: Start with the Spot Healing Brush
Make a copy of your Background layer by pressing Com-
mand-J (PC: Ctrl-J). Double-click the name of this new 
layer and rename it “furniture removed.” You’ll want 
to remove the smaller elements first so that Photoshop 
will have more areas from which to sample when you 
work on the larger, more difficult areas. In this example, 
take the Spot Healing Brush tool (J) and start “trimming” 
the plant by clicking at the outer edges and dragging in 
along the leaves. Use the Bracket keys on your keyboard 
to quickly change the size of your brush as needed. 
You’ll be able to remove a lot of the plant quickly.

Next, paint over sections of the lampshade, its pole, and shadow on the other wall as best you can with the Spot 
Healing Brush. If you get some funky results, instead of Undo, try going over it a couple of times, because the brush is 
a “learning” tool and tends to get better after a couple of tries. (For more information on cloning and healing and how 
they work, check out my Clone and Healing Crash Course on www.kelbyone.com.) A good point to think about here is 
how precise you want your cloning and healing to be. This is more than likely going to be just a rough idea of what the 
room is going to look like, so only spend time being precise if you want to.

Step Three: Clone out the Plant
Once you’ve eliminated the smaller items with the 
Spot Healing brush, let’s use the Lasso tool (L) and 
Content-Aware Fill to work on the larger stuff. Draw 
a quick lasso around the plant; don’t worry about 
including part of the floor. We’ll work on the floor sep-
arately, so it doesn’t matter if it has some odd areas 
due to cloning out other elements. Press Shift-Delete 
(PC: Shift-Backspace) to bring up the Fill dialog, choose 
Content-Aware in the Contents drop-down menu, 
check on Color Adaptation, and click OK. Sometimes 
Content-Aware Fill does a great job, but there may be 
a section that’s just weird. Simply press Command-D 
(PC: Ctrl-D) to deselect, redraw the lasso around that 
smaller weird part, and repeat Content-Aware Fill. Once 
the odd section is small enough, you can always use 
the Spot Healing Brush, the Healing Brush, or the Clone 
Stamp tool to fix it. 

Step Four: Clone out the Couch
Once that’s done, you’ll have an even bigger section of 
wall to use for cloning out the couch. Photoshop uses part 
of the existing image as the base for the Content-Aware 
Fill, so the more clean wall you have, the more likely 
Photoshop will get it right, with less weird areas. Treat the 
couch the same way as you did the plant: Start with the 
whole couch, and then use Content-Aware (or use the 
Spot Healing Brush) on any results that don’t look right. 
With just a few clicks, you should have a workable wall 
with no furniture. 
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Step Five: Select Front Area  
of Flooring
Since the very front part of the floor is clear of 
objects, we’re going to use it to “resurface” the 
rest of the room. It won’t be a perfect match 
with the width of the lines of the wood, but it 
will definitely do the trick for what we’re doing. 
Grab the Rectangular Marquee tool (M) and 
make a selection around the front section of the 
floor, making sure not to include the baseboards.

Step Six: Transform the Flooring
Press Command-J (PC: Ctrl-J) to copy this section 
of floor to its own layer. Rename this layer “floor.” 
Enter Free Transform by pressing Command-T 
(PC: Ctrl-T), and drag the top-middle handle to 
line up with the baseboard on the back wall. In the 
Layers panel, drop the Opacity down to around 
80% so you can see through this layer enough to 
tell where the baseboards are located. While you 
still have the transform handles active, Right-click 
inside the bounding box and select Perspective 
from the options. Grab one of the lower-corner 
transform handles and drag outward to get the 
right perspective of the floor. You may have to 
zoom out so that you can pull out the corners 
even more. Do your best to align the flooring 
with the side walls. If you find that the lines don’t 
match up perfectly on both sides, Right-click and 
choose Distort. Now you can drag each corner 
handle individually, which should allow you to 
line up each side of the flooring with the walls. 
Press Enter to commit the transformation.

Step Seven: Mask the Flooring
Once you get the floor looking as best you can, 
press OK. Using the Polygonal Lasso tool (nested 
under the Lasso tool in the Toolbox), click 
around the bottom edges of the baseboards and 
the front section of the floor to create a selec-
tion. Click on the Add Layer mask icon (circle in 
square) at the bottom of the Layers panel. The 
layer mask will hide everything outside the selec-
tion so that it now looks as if the new floor fits 
inside the baseboards. Raise the Opacity of the 
layer back to 100%.

Select front area of flooring

Perspective transform for proper visual angle

Create a selection to mask off extra areas of the floor› 
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Step Eight: Copy the Walls
With the Polygonal Lasso tool still active, use it to select 
the walls. Click around the outside edges of the walls to 
select them: Do not include the baseboards. The easiest 
way to remove the window from the selection is to hold 
the Option (PC: Alt) key and click around the window 
and its frame. In the Layers panel, click on the furniture- 
removed layer to make it active, and press Command-J 
(PC: Ctrl-J) to copy the selection of the walls to its own 
layer. Rename this layer “wall color” and drag it to the 
top of the layer stack. This will be our “magical” col-
or-changing layer that we’ll set up in the next step. Note: 
If you want to apply a different color to each wall, then 
you’ll need to select each wall with the Polygonal Lasso 
tool and copy it to its own layer. We left the window 
frame unselected, but you can include that in the selection 
if you want to change its color as well.

Step Nine: Changing Color
In the Layers panel, decrease the Fill setting (below 
Opacity) for the wall color layer to 0%. This will make 
the walls on this layer disappear, but will allow for any 
layer styles you apply 
to be seen—in this 
example, any colors 
we want to add. Dou-
ble-click to the right of 
the wall color layer’s 
name to bring up the 
Layer Style dialog. Click 
on the Color Overlay 
option in the list of 
Styles on the left. In 
the Color Overlay set-
tings, you’ll be able to 
blend in any color on 
top of the walls.

By default, it applies a flat color all the way across 
the walls. The secret is in the blending; simply change 
the Blend Mode drop-down menu to Linear Light 
instead of Normal. Now the shading and shadows 
of the original walls show through. You can adjust 
the color output by clicking on the color swatch and 
experimenting with the tone of the color chosen,  
but don’t forget you can use the Opacity slider to con-
trol how the color looks on the walls. (This will let you 
visually dial up whatever color you want; but it’s not 
specific enough to go to the paint store with the hexa-
decimal number from your screen and have it match.)

Red room

Name the layer and  
decrease the Fill

Color Overlay set to Linear Light

Select just the walls you want to change  
(we’ve hidden the other layers in this image)
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Step Ten: Furniture Hunting  
(i.e., Image Sourcing)
At this point, you, your spouse, or your decorator may have 
some idea of what kind of furniture should go in the room, 
but if not, then you’ll get to spend some time shopping 
online. Once you find a potential candidate for the room, 
select the item: for instance, this couch. Hopefully, the site 
will have a larger zoom view of that item and, if you’re 
lucky, it will be on a white background. If they don’t have 
a zoom view, then you might have to do a bit more Inter-
net searching to find a decent image of the couch you’re 
interested in. Or, you could go to a nearby store and take 
a photo from the same perspective as the room. (Important 
note: As you’re only using these images to visually com-
pare one couch with another for personal use, you should 
delete them after you’re done, and never use them for any 
other project. Please respect the company’s copyrights.) You 
needn’t be too concerned about making the scene perfect; 
chances are you’ll only find a low- to medium-resolution 
image of the couch, and that’s perfect for this project. (The 
images we’re using for this tutorial are stock images that we 
purchased from Adobe Stock. If you’re a KelbyOne member, 
you’ll find the image of the red couch in the download files.)

Step Eleven: Cutting out the Couch
Open the couch image in Photoshop and use the Quick 
Selection tool (W) to make a selection around the couch. 
(It will be easier on a white background; but quite doable 
with any type of photo-
graph.) While the marching  
ants are dancing around 
your couch, click on the 
Refine Edge button up in 
the Options Bar. When 
the dialog appears, use 
the sliders to help refine 
the selection. In the View 
drop-down menu, you can 
change the background 
while you’re working to 
see how the selection looks. 
Try using On Black to help 
see any sneaky white jag-
gies. Once it’s the way you 
want, set the Output To drop-down menu to Selection, 
click OK, and then do the Command-J (PC: Ctrl-J) trick to 
copy that selection onto its own layer. If you were doing  
this as a commercial project, and using high-resolution 
stock imagery, then the Pen tool (P) would be the best 
way to cut out objects, but for this level of production, 
down-and-dirty is better.

Quick Selection tool

Final output

Refine Edge settings

Super-duper fancy website

Furniture on white background
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Step Twelve: Placing the Couch
Use the Move tool (V) to click-and-drag that couch layer into 
the room image. If you’re using your own room and couch 
images, and the couch is too small, you might want to press 
Command-Z (PC: Ctrl-Z) to undo moving the couch, and 
then change the size of your room image (Image>Image 
Size) down to around 1,200 pixels or so on the long end. 
Now when you drag the couch into the scene, it should 
fit a bit better. A helpful tip at this point is to Right-click 
on the layer and choose Convert to Smart Object from the 
menu. Now you can use Free Transform to resize the couch 
as often as you want, without losing any more resolution.

Step Thirteen: Create a Shadow for the Couch
No matter how quick this project is, our eyes will rebel 
against an object floating in space, so here’s a quick 
shadow for you. Click the Create a New Layer icon at 
the bottom of the Layers panel, and drag this new layer 
below the couch layer. Use the Rectangular Marquee tool 
(M) to create a rectangular selection below the couch. 
Press D to set the Foreground color to black, and press 
Option-Delete (PC: Alt-Backspace) to fill the rectangle 
with black. Press Command-D (PC: Ctrl-D) to deselect. 
Enter Free Transform, Right-click inside the bounding box, 
and choose Distort. Drag each corner to match the bottom of the couch, but extend it more on the side away from the window 
(as shown). Press Enter. Now apply a Filter>Blur>Gaussian Blur, and lower the Opacity of the shadow layer to where it looks 
natural for the scene. This will help anchor the couch to the room.

Place couch in room

Create rectangular shadow

Adjust size and shadow opacity › 
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Step Fourteen: Adding More Stuff
Once you get the hang of placing the couch, you can 
now quickly add other elements to see how they’ll all 
work in the room. If you already have the frames, rugs, 
and plants at your house, then you could photograph 
them; if not, go website shopping again (just like with 
the couch). Use your transforming powers to make sure 
the objects have the right perspective, especially the rug. 
It’s easy to add shadows to the frames and the rugs: Just 
add a Drop Shadow layer style, and set the Angle of the 
Global Light in the same direction as the light source for 
the room (the window in this case). Plants and lamps 
are a little trickier. Just do the same thing as you did in 
the last step with the couch, but instead of creating a 
rectangular selection, either draw a rough selection with 
the Lasso tool to match the shape, or use the Elliptical 
Marquee tool for oval shapes.

Step Fifteen: Repaint the Walls
Now that you’ve placed all of the decorative elements in 
the room, let’s see how they’ll look with different wall 
colors. Go back to the wall color layer and double-click 
on the Color Overlay style. Click on the little color swatch 
icon to open the Color Picker. Now you can choose 
from any color in the rainbow; however, you’ll notice 
that, with the Linear Light blend mode, you’ll need to 
pick darker colors because this mode lightens colors as 
it blends them with the walls. Don’t forget to use the 
Opacity setting for Color Overlay to help tweak the 
intensity of the color. Once you get the hang of it, you 
can try all kinds of colors.

Step Sixteen: Rinse and Repeat
This is where it can get fun or chaotic, depending on 
your personality. What if you created several different 
looks to give your spouse a choice? Do you want to 
swap everything out and try a different color on the 
walls, or just move the picture frames around? How far 
do you want to go with this? If you really want to take 
this to an insane level, you could measure all of the  
furniture (or get the measurements off the website) 
and use the measuring tools to fit everything in the 
scene perfectly. By the time you did all that, however, 
your spouse may have decided to leave you and take 
the furniture.

Ensure Global Light Angle is the same direction  
as the main light source (window)

Color Overlay settings

Walls changed for new look

Different set of stuff
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New wall color

Different stuff

Color change

ALL IMAGES ADOBE STOCK 

So now that you know how to do this, beware: This 
can lead to interesting situations for couples. For 
example, you’ll possibly spend a lot of time looking at 
furniture online with your spouse, and chances are one 
of you will enjoy that more than the other. You’ll then 
spend a good bit of time talking about colors, plants, 
frames, and rugs, and hopefully, you’ll both consider 
that quality time. You’ll then spend a lot of time in 
Photoshop rearranging the furniture and frames in the 
room—most likely with your spouse sitting right next 
to you, directing your every move. Now you’ll be faced 
with a moral dilemma. If your spouse sees how easy 
it is, she or he may want you to do it for more rooms 
in the house. So, do you make it look harder than it 
is, act like a martyr, and maybe your spouse will be 
hesitant to ask in the future? Or, do you use it as credit 
in the marriage “bank” for a time in the future when 
you screw up? This is just one of those nagging ques-
tions that arise when you open this Pandora’s decora-
tor’s box. My advice: make sure to use your newfound 
power wisely.

The one great advantage of this technique is that 
it’s easily transferable to any project where you need to 
change the walls, part of a scene, or a section of an image. 
Good selections and blend modes are the secret to many 
great effects in Photoshop, and now you’re one step 
along in your learning journey. ■ 
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DesignMakeover
C O L U M N  ›  ›

JAKE WIDMAN

“I like to say that if it can be made 
by one person, I can make it.”

Rachel McConnell used to work at the DIY project-sharing site, 

Instructables (www.instructables.com), and she says that she used 

her years there to learn “a huge variety of fabrication skills.” When 

Autodesk bought Instructables, she decided to focus on physical 

rather than virtual objects, and adopted the name “Dr. Shiny,” a 

moniker she had used online from time to time.

Her work spans a wide range, from rotating wooden benches to 

foam animal ear shapes for a raver headset; the heart-shaped fiber-

glass-and-steel structure and housing for an electronic art piece; 

and laser-cut acrylic jewelry. “Currently, I’m working on an 8' tall 

welded-steel T. rex sculpture,” she says.

As part of a trade, a friend designed her current business card 

and logo, for which McConnell came up with the idea of the gears. 

“I can’t explain exactly why; I just feel them,” she claims. “I guess 

they represent both the creative gears in my head and the machin-

ery I often use to make the things I make.” She hands the cards out 

at events that feature unusual objects or activities where people 

might want or need a unique, custom physical object. But on the 

whole, she doesn’t do a lot of promotion, being a self-described 

“introverted, solitary maker.”

McConnell still likes the card and the logo, even though she 

says she’s not as adamant about the gears as she used to be. She 

likes the logo font as well: As a whole, she thinks it does a good 

job of communicating “the combination of expertise and whimsy 

that I feel I have.” Nevertheless, she agreed to let three design-

ers take a crack at custom-fabricating a new logo and card that 

will represent her work and mindset. “I like to say that if it can be 

made by one person, I can make it,” she explains. She’d like her 

new card to project that combination of competence along with a 

bit of quirkiness—“but without a picture of a sewing machine or 

anything like that.”

card making
before

CLIENT
Rachel “Dr. Shiny” McConnell 
http://drshiny.com

makeover submissions
WE’RE LOOKING FOR PRODUCT PACKAGING OR LABELS, PRINT ADVERTISEMENTS, WEBSITES, AND MAGAZINE COVERS THAT ARE CURRENTLY IN THE MAR-
KETPLACE FOR FUTURE “DESIGN MAKEOVERS.” SO IF YOU OR SOMEONE YOU KNOW HAS A DESIGN THAT YOU’D LIKE US TO CONSIDER MAKING OVER, OR 
IF YOU’RE A DESIGNER AND YOU’D LIKE TO BE CONSIDERED FOR A FUTURE “DESIGN MAKEOVER,” SEND US AN EMAIL AT LETTERS@PHOTOSHOPUSER.COM. 
(NOTE: THIS IS PURELY A DESIGN EXERCISE AND THE DESIGNERS DO NOT WORK DIRECTLY WITH THE CLIENT, CREATE FUNCTIONING WEBSITES, ETC.)

http://drshiny.com
mailto:letters%40photoshopuser.com?subject=
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“I turned the gears into an isometric 
pattern in the background for 

looks, and also as an Easter egg 
for fabricators and designers...”

After brainstorming catchphrases for Rachel McConnell’s trade,  

I came up with “custom fabricator of almost anything,” and “Cer-

tified Thingmaker,” playing off the doctor concept in “Dr. Shiny”. 

My goal in redesigning the business card was to use a medical 

theme: one where, upon further inspection, the viewer would 

appreciate the “quirkiness” that fits Dr. Shiny so well. 

I wanted to keep the gears in my redesign, because Dr. Shiny 

said, “They represent both the creative gears in my head and the 

machinery I often use to make the things I make.” I turned them 

into an isometric pattern in the background for looks, and also as 

an Easter egg for fabricators and designers who are familiar with 

isometric drawings.

I soon had the general layout complete, but what I spent most 

of my time on was choosing the font for “Dr. Shiny” on the front 

of the card. I wanted to find an industrial, yet clean font, and my 

first candidate was Wireframe, which resembles a 3D extruded 

version of Bebas; but I knew it wouldn’t last. The lines of the wire-

frame were clashing with the isometric pattern and, even with-

out the pattern, the logo looked chaotic and messy. I continued 

searching and eventually found Emilie Rollandin’s RollandinEmilie 

as an equivalent that visually denotes construction. The rest of the 

content is in Helvetica Neue to signify the precision and clean lines 

in Dr. Shiny’s fabrication. One of the last changes I made to the 

card was switching the color scheme from blue to one with a white 

background, to improve legibility.

APPLICATION USED: Adobe Illustrator CC 

MACGUIRE RINTOUL  
AU SÉRIEUX is the newfound alias of Vancouver-based artist Macguire Rintoul. Arising from Rintoul’s current studies in Interactive Arts & 
Technology at Simon Fraser University, AU SÉRIEUX is a freelance project dedicated to applying skills learned throughout a life as an artist, 
providing clients with creatively inclined content, getting a head start on career goals, and fulfilling a passion.

Rintoul has a visual-design history dating back to the angsty years of middle school, when he drafted the cover of his band’s prospective 
album with a No. 2 pencil and a blank sheet of paper. AU SÉRIEUX is the result of years of ideas, projects, concepts, plans, successes, failures, 
and pseudonyms. It’s the result of an aspiring creative director managing to pursue an intention enough to make it tangible. Abundant creativity 
and endless inspiration are of the highest importance for this young mind. 

about the designer

 ›  ›  D E S I G N  M A K E O V E R

DESIGNER
Macguire Rintoul 
http://auserieux.com

after

http://auserieux.com
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After seeing the client’s work and current branding, I decided to 

have a little fun with her logo. Her website depicted numerous 

eclectic creations that were fun to look at and had a strong feel-

ing of nostalgia. Based on feeling, I decided that a retro-inspired 

logo would be a good choice to represent her brand and what 

she does creatively.

The type and the objects in the current branding didn’t seem to 

complement each other effectively, which can make it difficult to 

brand other products. Some elements may need to stand on their 

own but still maintain the same look and feel of the overall brand. 

I wanted to create a logo and business card with elements that 

can be used on the client’s website and other marketing materials.

The original card had “Dr. Shiny” on both sides. I thought the 

name didn’t need to be repeated to get the point across. I placed 

the logo prominently on the front as an immediate attention grab-

ber that would make the viewer want to flip the card over and see 

what “Dr. Shiny” was about. On the other side, they’d find that 

there’s an amazing artist that makes beautiful things.

For a color palette, I decided to go with complementary col-

ors in orange and blue, leaving the main type of the logo white.  

I chose the font Pacifico by Vernon Adams, because it possesses 

the retro feel that I wanted to get across, and it complemented the 

shapes in the logo.

The secondary font is called Acid, from Acid Type: I needed a 

font that was clean and could get the pertinent information to 

the viewer effectively and still work with the primary font. With 

all these elements together, I think an eye-catching business card 

was born.

CHRISTOPHER MALLOY 
Christopher Malloy is originally from South Carolina, where he spent three years studying design at Winthrop University in Rock Hill. After a 
stint in the Air Force, during which he moved to Colorado, he graduated in 2011 from Colorado Technical University (in Colorado Springs, also 
home to the Air Force Academy) with a degree in advertising and digital media.

After graduating, in addition to gaining experience as an intern for Snowboard Colorado Magazine, he launched his own freelance business 
in Denver. There, he works with such clients as the University of South Carolina, the U.S. Air Force, and startups both in Colorado and across 
the country. For the past year, Christopher has worked for CACI International, Inc., supporting and designing for the United States Government, 
and he recently won an award for logo design.

APPLICATIONS USED: Adobe Photoshop CS6 and Adobe Illustrator CS6 

about the designer

“I placed the logo prominently on 
the front as an immediate attention 

grabber that would make the 
viewer want to flip the card over…”

after

DESIGNER
Christopher Malloy 
www.cmalloydesign.com

D E S I G N  M A K E O V E R  ›  ›

http://www.cmalloydesign.com
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First, I had to find out who Rachel “Dr. Shiny” McConnell is and 

what she does. I put on my marketing research hat, visited her 

website, and read her comments regarding the good, bad, and 

ugly of her current business card. When researching like this,  

I look for words that will help me focus on what images to use. As  

I reviewed Rachel’s website, the words that came to mind were: 

fun, creative, fabrication, crazy-mad skills, diverse knowledge and 

interest, and technical. 

My normal process is to design three versions in black-and-

white to determine the strength of the design. After I’ve chosen 

the design, then I decide on the color(s). I opted for a design 

that’s clean and modern, has an edge to it, and says “different.” 

I decided on Adobe Myriad Pro font for the logo because of its 

straight lines, which worked well when I applied the artistic Rough 

Pastels effect. I replaced the period and a couple of strokes with 

gears to emphasize the process of putting things together.

On the front of the business card, I placed the logo, “Thing-

maker” (the title), and the website address. I set the title in Sten-

cil to represent applying a pattern, because this is what Dr. Shiny 

does. The spiral background image represents the whimsy of the 

various fun items Rachel has created. 

I used the same Stencil font for Rachel’s name on the back of 

the card. The image of the welder and sparks represents the fab-

rication component of Rachel’s skill set. The remaining font used 

was Adobe Minion Pro, which I felt went well with the Stencil 

font. I also carried the use of gears throughout to hold the various 

social-media icons.

after

“I opted for a design that’s 
clean and modern, has an edge 

to it, and says ‘different.’”

WANDA CLOUSTON
Wanda Clouston is the owner of Eiram Creative, a graphic and Web design and visual communication company in Detroit. She holds a Bach-
elor’s Degree in Business Administration in Marketing from Davenport University in Grand Rapids, Michigan, as well as a certificate in digital 
arts from Detroit’s College for Creative Studies. 

Wanda planned and then developed her past job responsibilities into her current career as a designer—the key that unlocked her finest 
potential. She currently works with small businesses (local, national, and international) and nonprofit organizations to assist them in commu-
nicating their messages, both through print and Web applications. Wanda has experience in project management and event marketing and, 
as an adjunct instructor, has taught Adobe Dreamweaver, InDesign, and Photoshop at various higher-education institutions.

With more than 10 years of experience, Wanda continuously seeks knowledge within the design industry. She has a thirst for technology, 
but remains hungry for ways to delight clients. ■ 

about the designer

APPLICATIONS USED: Adobe Photoshop CC and Adobe Illustrator CC 

 ›  ›  D E S I G N  M A K E O V E R

DESIGNER
Wanda Clouston 
www.facebook.com/eiramcreative 

https://www.facebook.com/EiramCreative/
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ARCHITECTURAL
PHOTOGRAPHY

EVALUATING THE SCOPE OF THE PROJECT

Before you start photographing anything, you’ll need to walk the job site with the client so that you can discuss which areas of the building 

are to be photographed and from which angles. It’s best to visit the location in advance with the client. If that isn’t possible, reviewing a 

building plan and shot list with the client is a helpful alternative. By walking the building, you’ll be able to establish what time of day is 

best for each shot. This will help determine if you’ll need access to control the building lights, what type of equipment will be necessary 

for each particular shot, and if you’ll need strobe or tungsten lighting. This is also the time to learn what the client is trying to convey with 

these photographs.

Back in high school I thought I’d become an architect until I picked up my first camera and started photo
graphing. It seemed that all I photographed was architecture. I’ve been fortunate to merge my love of 
both architecture and photography into a profession and, after 30 years, I still look forward to my next 
assignment. One of the most important aspects of architectural photography, whether shooting for an 
architect, interior designer, builder, or a magazine, is to create dramatic images. Here are ten tips that will 

help you come away with great architectural photographs.

by Randy Van Duinen

 TEN SECRETS FOR



› 
› 

k
e

l
b

y
o

n
e

.c
o

m

075

TILT-SHIFT AND OTHER LENSES

You don’t need a lot of lenses for architectural pho-

tography, but one I’d highly recommend investing 

in is a 24mm tilt-shift lens. I use this lens for about 

80% of all my interior photographs and about 50% 

of my exterior images. It’s an incredibly sharp lens 

that allows you to set your camera perfectly level, and 

then shift the lens to compose the image the way 

you want. 

Other suggested lenses include a 16–35mm 

zoom lens for a wide angle of view (especially for 

exteriors), and a 24–70mm zoom lens (best for exte-

riors and detail interior images). Although not often 

used, a 70–200mm zoom lens does come in handy 

when you need to photograph from a distance. If 

you have the budget, I’d also suggest a 17mm tilt-

shift lens, which is great for very large spaces; but 

it shouldn’t be overused, as it has some distortion 

issues in the corners when used close up to a subject.

USE A TRIPOD

Architectural photography is all about keeping your perspective of the building correct, especially perpendicular lines. If you want a tack-sharp 

image, you need to start with a good sturdy tripod; adding a couple of sandbags will help keep your tripod in place. After deciding where the 

camera will be positioned, you need to level your camera. This can be accomplished with built-in levels in newer DSL cameras. If your camera 

doesn’t have a built-in level, you can purchase one for around $30, and place it in the camera’s hot shoe. If you don’t have a tilt-shift lens  

(see the next tip), you can level out your horizontal lines in camera and correct your vertical lines in Photoshop.
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CAMERA PLACEMENT

One of the most important decisions you make 

when photographing architecture is camera 

placement. Most of the time it’s best to shoot 

from a corner, as this will give the building 

or room more dimension, depth, and inter-

est. Very rarely will you find yourself shooting 

straight onto a building or interior, but there are 

times when the architecture will lend itself to a 

straight-on camera placement, and when this 

happens it can be a very powerful image. When 

photographing a residential exterior, try to place 

your camera on the opposite side of the garage 

doors to minimize their size and prominence.

COLOR TARGET

The use of a color target is essential as, most 

of the time, you’ll be photographing in lights 

that have mixed color temperatures. Using a 

color target will speed up your postprocessing 

and help you determine the type of color cor-

rections you’ll need to apply to your images. 

In many cases, you’ll have to photograph the 

target in different locations because of two or 

more lighting sources with different color tem-

peratures. By having the target information in 

different locations you’ll be able to make the 

color adjustment, and in the end have the cor-

rect color for the image.

PHOTOGRAPH AT TWILIGHT

One of the most dramatic (and client-requested) 

shots in architectural photography is the twilight 

image. It doesn’t matter if it’s an interior or exte-

rior image, photographing at twilight will add 

drama to the architecture and your photograph. 

There’s only about a 20-minute window of time 

when ambient and artificial light will have the 

same color temperature and exposure range, so 

planning for the shot is a must. 

When shooting at twilight, you should 

plan on making three different images: the 

first when the sun is just below the horizon; 

the second about 10 to 20 minutes after the 

sun has set (this is usually the best and most 

popular); and the third when the sky is almost 

black (in case you need to change some of 

the lighting). Remember to give yourself extra 

time to set up for a twilight shot. Place your 

lights in the right location and test them to 

make sure the circuit breaker won’t trip in the 

middle of shooting (as has happened to me). 

P H O T O G R A P H Y  S E C R E T S
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WATER DOWN DRIVEWAYS

Especially in residential photography, watering down driveways and sidewalks will not only add interest to your photograph but will also 

darken the driveway so it’s not the brightest spot in your photo. Having a reflection of the building or the sky will add color and break up what 

tends to be a very boring part of the photograph.

ARTIFICIAL LIGHTING

In order to photograph architecture, you’ll need 

both strobe and tungsten lights to control the dif-

ferent lighting conditions. When using strobes to 

light an interior, the goal is to balance your light-

ing with the ambient light. This is accomplished by 

using softboxes or umbrellas to fill in the shadows, 

and a few lights with grids to add interest to key 

elements in the room. Strobe lighting tends to be 

a little flatter than tungsten, and for this reason 

I prefer tungsten lighting. With tungsten, you 

have more control and are able to create a more 

dramatic feeling—and they’re a lot less expensive 

than strobes! You can use tungsten lights for 

both interior and exterior photographs, allowing 

you to balance your lighting for twilight shots. 

(Note: For more on how to light an interior space 

with tungsten lights, see “Light It,” page 80.)
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P H O T O G R A P H Y  S E C R E T S

TETHERED SHOOTING

Architectural photography is a collaboration between you and your client. Tethering your camera to the computer allows you and your client 

to view and evaluate a larger image, where you can check focus, look for items that shouldn’t be in the image, and make changes to the 

styling. Allowing the client to view the image on the computer will let him voice any concerns, and then you can make any changes so that 

he gets the best image possible.

BE CAREFUL WITH HDR 
PHOTOGRAPHY

HDR photography is a great tool for archi-

tectural photographers, but one that can be 

overused. Starting with a correct exposure and 

processing the image in Adobe Lightroom will 

usually get you a great final image. Adobe has 

added a new feature in Lightroom CC that 

allows you to process an HDR image with great 

results. Merge to HDR can give you a very real-

istic HDR image, and you can use all the adjust-

ments that you’re already using in Lightroom to 

tone-map your image.

One of the great things about architectural 

photography is that your subjects don’t move, 

show up late, or have an attitude. It can be very 

rewarding, and I hope that you’ll be able to use 

some of these tips the next time you’re out pho-

tographing architecture. ■

ALL IMAGES BY RANDY VAN DUINEN



http://kelbyone.com/shop


 >>LIGHT IT

THERE ARE MANY DIFFERENT WAYS TO PHOTOGRAPH ARCHITECTURAL 

INTERIORS, SUCH AS USING AVAILABLE LIGHT, STROBE LIGHTING, 

OR MY FAVORITE, TUNGSTEN LIGHTING. I LIKE TUNGSTEN LIGHTING  

BECAUSE OF THE WARM LIGHT TONES, COMPACT SIZE, AND THE COST 

COMPARED TO STROBE LIGHTS. 

INTERIOR 
 ARCHITECTURAL
 PHOTOGRAPHY
 WITH TUNGSTEN LIGHTING  

By Randy 
Van Duinen



You also have the advantage of seeing the light and making 

adjustments as needed, instead of checking the back of the cam-

era or computer screen after the image is created. Here are a few 

tips to get you started with tungsten lighting.

CAMERA PLACEMENT AND ROOM STYLING
The first thing to decide when photographing an interior location 

is camera placement, which will determine what lights will be 

needed, their location, and any problems you may have with reflec-

tions in windows or glass. Tethering the camera to a computer 

helps in evaluating the shot and discussing images with the client. 

For this photograph of the Atkins Global lobby in Tampa, 

Florida, I used a Canon EOS 5D Mark III with a 24mm tilt-shift 

lens. (Note: For more on tilt-shift lenses and other architectural 

photography tips, see “Photography Secrets,” page 74.) 

After determining camera placement, you’ll have to decide 

on styling. Typically, when working with an interior designer or 

architect, he or she will be in charge of the styling for the shoot; 

however, there are times when you may be your own stylist and 

have to make decisions on what and where furniture and acces-

sories will be placed. In most cases, the rule with styling in archi-

tectural photography is “less is more.” As you can see in these 

before- and after-styling shots (before adding lighting), I removed 

knickknacks from the top of the receptionist’s desk, rearranged 

chairs and tables, and removed things from the conference area 

in the background to achieve the look the client wanted. 

› › L I G H T  I T

ADDING THE LIGHTS
I prefer Mole-Richardson Mini-Mole Fresnel Tungsten Lights 

(http://bhpho.to/1BdkHyt). They’re 250 Watts and color bal-

anced at 3200 Kelvin. 

These lights are used in 

the movie industry, have 

a Fresnel lens with the 

ability to go from a spot 

to a wide beam of light, 

and are very durable. 

In this shoot, the main 

source of light was from 

the fluorescent lights 

in the ceiling, so to balance the tungsten lights, I added a Rosco 

CT +1/2 green gel to all of the Mini-Moles. If we didn’t add the 

gels, the image would have a magenta cast that would need to be  

corrected in Photoshop. 
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TIP: PUT EVERYTHING BACK IN ITS PLACE
When photographing an office location, use your cam-

era phone to take reference pictures of each cubical, 

showing where personal items are located. This will 

allow you to put them back after the shoot, as some 

people may get upset about your moving their things. 

This may also help maintain a continued good relation-

ship with your client.

Before styling After styling but before adding any lights

http://www.bhphotovideo.com/c/product/167187-REG/Mole_Richardson_2801_Mini_Mole_Fresnel_Tungsten_Light.html
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L I G H T  I T  › ›

Start by adding one light at a time so that you can see exactly 

where that light affects the architecture, and then adjust it 

accordingly. If you try to add all of your lights at once, you may 

“over-light” the shot. Begin with either dark areas that need 

light or with an area that you want to emphasize more than 

others. In this case, the corner areas with signage were very dark 

and the boardroom in the back needed some extra light.

I placed a light on both sides at the front of the room to light 

up the signage, and added a barn door to each of them so that 

the light wouldn’t spill onto the ceiling. Next, I placed two lights 

in the boardroom to light up the side walls. I wanted these walls 

to be a little brighter so a viewer would be drawn into the shot, 

tape placed on the edges of the barn doors. The great advantage 

of masking tape is that it lets you control exactly where you want 

to reduce the light, but still have it blend evenly in the photo.

ACHIEVING CORRECT COLOR
When working with interior designers and architects, you need 

to take steps to achieve correct color in every image. To make 

sure I have the correct color, I use a Photovision 24” One Shot 

Digital Target (http://bhpho.to/1AdKPnq). I have my assistant 

hold it in the predominant light so I can get a gauge for when  

I process the images in Adobe Lightroom. Because we’re photo-

graphing with mixed lighting, we took several target readings in 

different areas of the room. This helps in postprocessing so I can 

judge the different lighting sources.

Boardroom lights only

Boardroom and side lights

and also to let the frosted glass show through. Because there 

were windows in the boardroom, we had to wait until the sun 

was almost down before we were able to take this shot.

The last light was placed near the camera, focusing on the 

receptionist desk. I used a barn door 

to control light from spilling over onto 

the white areas and blowing them 

out; but even with the barn doors,  

I still had spillage on the white edges 

of the desk. An easy way to take care 

of that is with regular old masking 

http://www.bhphotovideo.com/c/product/429983-REG/Photovision_DT24011_24_One_Shot_Digital.html
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› › L I G H T  I T

RETOUCHING
I first processed the final image in Adobe Lightroom where 

color temperature was corrected, shadows were lightened, and 

highlights were taken down. Next, I brought the image into 

Photoshop where I removed ceiling fixtures, cleaned up walls 

Final before retouching

Final after retouching 

TIP: NO FOOTPRINTS
Footprints in carpeting are hard and time-consuming to 

remove in Photoshop. By using a carpet rake, you can 

save yourself a lot of time, make the carpet look con-

sistent, and impress your clients with your awareness 

of details. You can find these rakes on the Internet or 

at a cleaning-supply retailer for around $30, and they’ll 

make your interior carpets look great.

and floors, slightly darkened windows, and color corrected the 

wall behind the desk. As I didn’t want to crop through the mid-

dle of the words on the left wall, I had purposely positioned my 

camera slightly off center. Now, by using the Edit>Transform 

tools in Photoshop, I corrected the horizontal lines to make the 

image look more symmetrical.

A SECOND SHOT
This particular client also requested a photo from one side of the 

lobby. I prefer to shoot interiors from a corner, as it tends to give 

the room more depth and dimension than a straight-on shot.  

I set up the camera angle, but this time we needed to add fill light 

to the shot, especially to the back of the chairs in front of the cam-

era. We used a Lowel Tota-light (http://lowel.tiffen.com/tota) 

attached to an umbrella to accomplish this.

http://lowel.tiffen.com/tota
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Before lighting

After lighting

L I G H T  I T  › ›

ALL IMAGES BY RANDY VAN DUINEN

The problem with the Lowel Tota-light was that we weren’t 

able to add the CT +1/2 green gel, as it would have melted all 

over it. Because we couldn’t use the gel, a magenta cast was 

visible on the chairs in front, and slightly noticeable on the back 

two chairs, but this was corrected in Photoshop.

If you enjoy architecture and design as I do, architectural pho-

tography can be a very rewarding way of expressing that love—

and a great profession as well. As you can see, using tungsten 

lighting is a great way to light architecture, and it has the added 

bonus of being affordable and easy to work with. If you’d like 

to try using tungsten lights, look for a local movie or video-rental 

business where you can rent the lights and try lighting an interior 

before purchasing them. ■

TIP: DIMMER SWITCH
Unlike the Mole-Richardson Tungsten Lights, which 

have metal screens to adjust the amount of light passing 

through, the Lowel Tota-lights do not. In order to adjust 

the 1000-Watt light, I built dimmers, which plug into 

the light and then into the wall socket. The dimmers 

are inexpensive to build (less than $15 from your local 

home-improvement store) and work very well for con-

trolling these large lights for both interiors and exteriors.

Final retouched image
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There are times where you’ll work through a series of images by 

yourself in Lightroom, and then there are times that you’ll work with 

a client to decide what images need to be edited. You’ll need to share 

a whole series of images with your client so he can pick the images 

that he’ll ultimately want to use. 

the one-page website
B Y  R C  C O N C E P C I O N

After 
the 

Shoot
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Lightroom has a great way to do this with their Web mod-

ule, but the module was relegated to the back burner (my 

opinion) in the last couple of versions due to its use of Flash 

technology. Lightroom CC has brought the Web module 

back to the forefront by nixing those galleries and replacing 

them with ones that are easy to use, based on HTML 5, and 

responsive to different types of browsers. Now is a great time 

to explore how to organize and share images with clients—

both from the Library module, as well as online. 

create collections first
When you go into the Web module, all of the images in your 

currently active catalog or folder will appear in the Filmstrip. 

To counteract this, first create a collection set in the Library 

module. Just click on the + icon in the header of the Col-

lections panel and choose Create Collection Set. Right-click 

the collection set, choose Create Collection for each set of 

images that you want to share with the client, and then drag 

those images into the appropriate collection. Not only will 

this allow you to control which images appear in the Web 

module, you can also later create a collection inside the col-

lection set for the images that you’ll need to edit. 

Tip: Lightroom gives you the option to Sort collections 

by Name or Kind when you click on the plus sign in the 

header of the Collections panel but there’s no way to cre-

ate a custom order. The collections are also sorted in the 

entire panel; you can’t create a custom sort order within a 

collection set. But, if you add a space or a dash in front of a 

collection’s name, it will appear at the top of the collection 

list. The more spaces or dashes you add, the further up it 

will appear.

explore the web module
Click on the Web module to see all the options for creating 

a website. In the Collections panel, click on the collection set 

that contains the collections you just created. After a couple 

of seconds, all of the images in all of those collections will 

appear in the default Web template. 

This template has been around since the inception of 

Lightroom and provides a decent experience for people who 

are just looking to share their images as simply as possible. 

The template displays each grid of images on their own 

webpage, and the webpages can be edited in the panels to 

the right. When you click on an individual image, the image 

appears in its own page; but this site seems to offer too many 

webpages for what we’re trying to do here, so let’s take a 

look at the new web templates: Grid Gallery, Square Gallery, 

and Track Gallery. 

Click on Grid Gallery (default) and watch as all the images 

load into a single page. Even better, as you drag a corner of 

the Lightroom window to resize the interface, the number of 

columns and rows changes, as well as the size of the images. 



› 
› 

k
e

l
b

y
o

n
e

.c
o

m

089

›  ›  l i g h t r o o m  m a g a z i n e  ›  ›

Resizing the window in Lightroom will give you a good idea 

of how this website will appear on different screen sizes, 

including mobile devices. 

The Square Gallery templates will display your images right 

next to each other as square tiles; Track Gallery also places 

the images right next to each other, but it shows the entire 

image. The real benefit with these galleries is that all of your 

images appear on a single page. I prefer the Grid Gallery, so 

we’ll start customizing this one. 

change the site colors and info
The first thing that we want to do is change the colors 

of the website. The background and text colors can be 

changed in the Color Palette panel on the right. Clicking on 

the Background color swatch will give you a series of colors 

to choose from. Click on the color you want to use and 

you’re done. I tend to use black, as I don’t want the color of 

the page to compete with the images I’m presenting. I also 

don’t want the filenames or text information to pop out, so 

I’ll change the text color to an off-white or gray color. 

In the Site Info panel, type the Gallery Title that you want 

to use. You’ll see it change in the top-left corner of the web-

page. The Gallery Author and Gallery Author URL are very 

important. You don’t need the client to go to your website, so 

instead of placing a Web address in this space, replace it with 

HTML code that will prompt an email message. In the Gallery 

Author URL, let’s add the following: mailto:jdoe@wherever 

.com (a fake email address for this example). This will launch 

the user’s default email program. You’re now good to go!

customize the image info 
If you’re sending this webpage to a client, you may want 

to include specific information with individual images. The 

Image Info panel is a great place to include this information. 

Select an image in the Filmstrip and switch to the Library 

module. In the Metadata panel, enter your descriptive text in 

the Caption field. Back in the Web module, click the Caption 

checkbox in the Image Info panel. The drop-down menu to 

the right will become active, allowing you to specify what 
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you want to use: Caption is the default option, and the one 

that we want. Click on the image to bring it into single-image 

view. You’ll see the caption you wrote below the image. 

You may also want to rank the images as well as apply 

color labels so you can give the client additional information, 

for example: “The images that are five stars are images that  

I think would work best for you; images labeled red are those 

that I think you can use for X,” and so forth. You can add 

ratings and color labels to each photo in the Library module, 

but to make them visible in your webpage, you’ll need to use 

the Title section of the Image Info panel. 

Turn on the Title option in the Image Info panel and click 

on the drop-down menu to the right of it. Selecting the Edit 

option will open a dialog where you can add any file informa-

tion to the filename that you want. 

Delete any of the 

entries that you see in 

the box near the top of 

the dialog, then start 

adding information by 

clicking the drop-down 

menus in each of the 

sections and selecting 

the option you want 

to add to the filename. 

Each item you add will 

appear in the box near 

the top. If the informa-

tion isn’t automatically 

added to the box, click 

the Insert button to the 

right of the drop-down 

menu. Keep in mind 

that if you don’t add 

any spaces or dashes in 

between each added 

item in the box, the 

information will appear 

jumbled in the filename. (Tip: Keep an eye on the Example 

filename above the box as you add information.) Ratings and 

Labels can be found under the EXIF Data section.

When you add Ratings and Labels, it will only add a num-

ber or the name of a color to the filename, which doesn’t 

make much sense by itself, so you’ll need to add some text to 

explain that it’s either a rating or a label. Click the Insert but-

ton to the right of Custom Text at the bottom of the dialog. 

Double-click the Custom Text item that appears in the box to 

enter your own text. You can drag around the items in the 

Example field as needed.

Click Done, and now the client will see the rating and 

color label in the filename in the individual image view.

You can even save this file naming for later use by creating 

a template for it. Just select Save Current Settings as New Pre-

set from the Preset drop-down menu at the top of the dialog. 

output settings and ftp
Once you’re finished with the text information, you should 

be good to go. In the Output Settings panel, keep the Qual-
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ALL IMAGES BY RC CONCEPCION

name that you specify in the Save As field will be the name 

of the folder that will be created at that location. This name 

will also be included in the URL address of the website. For 

example, if I save this site as “interiors1” and then upload this 

folder to my website at aboutrc.com, the full name you’ll need 

to get to this page will be http://aboutrc.com/interiors1.

I’m excited to see that Lightroom offers these new alter-

natives for people who self-host websites and gives users 

more control over where to see their images. Adding mobile 

options will definitely make people consider this oft-forgot-

ten module a whole lot more! ■

ity to around 75 so the images 

will load quickly on the client’s 

page. Under the Metadata 

section, make sure that Copy-

right Only is selected. (I’m not 

a big fan of sharing all of my 

EXIF information on a job, but 

I do want the client to know 

that the images have been 

registered.) Finally, click on 

the Sharpening checkbox and 

select Standard from the drop-

down menu so the images will appear nicely on a webpage. 

Now that the entire site is complete, you have a couple of 

options. To transfer the website to the Internet, you’ll need 

to use a protocol called File Transfer Protocol or FTP. If you’ve 

created a website with a hosting company, many of them 

provide an FTP username and password for you to log into 

the server. If they haven’t, you’ll need to contact your Web 

hosting provider’s technical support.

Lightroom CC has a built-in FTP program that will let you 

upload the information to your website. I usually use a sep-

arate FTP program to log into my website and upload. For 

Macs, I recommend CuteFTP (which is pretty good for PCs, 

as well) or Fetch.

You can also export the website into a folder that you 

can upload later. Click the Export button and Lightroom will 

prompt you to select where you want to save the site. The 

http://www.aboutrc.com
http://aboutrc.com/interiors1


Ever shoot some buildings downtown and they 

look like they’re leaning back? Or maybe the top of 

a building looks wider than the bottom, or a door-

way or just a whole image seems like it’s “bulging” 

out. All these types of lens distortion problems  

are really pretty common (especially if you use 

wide-angle lenses), but luckily for us, fixing them  

is usually just a one- or two- (maybe three-, sel-

dom four-, rarely five-, but I once did six-) click fix.

fixing lens  
distortion problemsLightroom 

Workshop B Y  S C O T T  K E L B Y

Excerpted from The Adobe Photoshop  
Lightroom CC Book for Digital Photographers
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step one:
Open an image that has a lens distortion problem. 
This one has a bunch—from lens vignetting in all 
four corners to the bulging of the Taj Mahal (just 
look at how the wall is bowing down from left to 
right and the tower on the left looks like it’s going 
to fall over on the Taj). We can probably fix most 
of these problems with one click just by turning 
the lens profile correction on (and this is always 
the first thing I try, because even if the automated 
profile doesn’t do the full job, if I have to go to 
the next phase of correction, it works better once 
a profile has been applied). So, applying a lens pro-
file correction is always my first step. Let’s go to the 
Lens Corrections panel (seen here), and click on the 
Basic tab at the top to see those options. 

step two:
Lightroom has a bunch of profiles built-in for the 
most commonly used lenses from most lens manu-
facturers. When you turn on the Enable Profile Cor-
rections checkbox (as shown here), most of the time 
it will find the proper lens profile for you and apply it 
(it knows which lens you used by looking at the EXIF 
camera data embedded in the file by your camera 
when you took the shot). If it can’t find one, you 
just have to help it out a bit by telling it your camera 
make and model (in the Profile tab) and it does the 
rest. In this case, it found the profile and we know it 
did, because it actually did something—the vignett-
ing in the corners is almost gone as is most of the 
bulging (look at the wall now). There are still other 
problems, but we’re on our way.

step three:
If you want to see the profile it applied (or if it 
didn’t apply a lens correction profile at all), click 
on the Profile tab at the top to see its options. 
If you don’t see your lens’s make and model in 
these pop-up menus, then just start by choosing 
your make. That alone will often nudge Lightroom 
enough to pick the model automatically for you, 
but if it doesn’t, just choose yours from the pop-up 
menu. What if you don’t see your exact lens there? 
Just pick the closest match you can find. Even if 
you find the exact make and model match, I often 
have to tweak the automatic settings a bit using 
the Amount sliders at the bottom of the panel. For 
example, if you thought it didn’t remove enough 
distortion, you can drag the Distortion slider to the 
right a little, and it lessens the amount of rectilin-
ear correction it applied to the photo (notice how 
the wall is a little flatter now?). Do the same with 
the Vignetting slider (as shown here). Having these 
sliders to tweak the results is pretty handy (and 
you’ll probably use them more than you think).
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step four: 
One of the most useful features here is Upright. 
These are automated, one-click corrections. You 
choose which kind you want, from just straight-
ening the horizontal or vertical lines to a full one-
perspective correction, and it usually does a really 
great job of it. However, to get the best results 
from Upright, you need to turn on the lens profile 
corrections first (by turning on the Enable Profile 
Corrections checkbox). To use Upright, click on the 
Basic tab again, and you’ll see five buttons: Off, 
Auto, Level, Vertical, and Full. The one that seems, 
to me, to work the best consistently is the Auto 
button. It doesn’t “overcorrect” (which Vertical 
and Full seem to sometimes do), and it’s usually 
the one I wind up going with. I clicked Auto here, 
and it pretty much stopped the building from lean-
ing back, and the tower on the left isn’t leaning 
nearly as far.

step five:
Before we move on to the next Upright button, 
did you notice in the previous step that to make 
its correction it wound up leaving white triangular-
shaped gaps in the bottom corners of the image? 
There are three ways to fix this: (1) Crop those 
areas away with the Crop Overlay tool. (2) Click 
on the Manual tab and drag the Scale slider to 
the right to scale the photo up in size until those 
white triangles go away (though you lose a little 
quality scaling up, but none from cropping down, 
so I’d prefer to crop it). (3) Take the image over 
to Photoshop, select those white areas and use 
Content-Aware Fill. Okay, back to Upright. If you 
click on the Level button, it does just one thing—
it tries to straighten your image. Even though it 
didn’t do much here (in fact, it actually looks worse 
than the Auto correction because all it’s doing is 
just straightening—nothing else), it usually does a 
great job of the simple act of straightening, so if 
that’s all your image needs, then click on Level. 

step six:
When you click on the Vertical button, it tries to 
make the vertical lines perfectly straight. Take a 
look at the sides of the Taj now, and it looks pretty 
darn straight, but it also looks a little like it has been 
stretched upward (making it look a little taller and 
skinnier). You can fix this by going to the Manual 
tab and dragging the Aspect slider to the left a little 
bit, which stretches the image out wider, so you 
can make it look normal again. Of course, either 
way, you’ll have to deal with those white triangle-
shaped gaps like I mentioned in the previous step, 
but at least the building looks right.
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step seven:
If you click on the Full button, it applies a full dose 
of all three—horizontal, vertical, and a perspective 
correction. It’s a little more extreme than choos-
ing the Auto button, which is a bit more balanced. 
So, don’t be surprised if, on a particular photo, you 
click on Full and it looks totally whacked, but Auto 
looked fine. I rarely wind up using the Full correc-
tion because it usually is too extreme, too wild, or 
it just doesn’t look good. 

step eight:
For this particular image, I felt the Auto correc-
tion looked best (but, of course, I usually think the 
Auto Upright correction choice looks best). We do, 
though, have that white triangle issue to deal with 
and, as I mentioned earlier, I prefer cropping the 
image rather than scaling it up to fill the space. But, 
what’s nice is Lightroom can auto crop away those 
areas for you. In the Basic tab, just turn on the Con-
strain Crop checkbox, and it auto-crops the image 
so those white areas are trimmed away (as you see 
here). Below, is a before/after up to this point.
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step nine:
If you don’t like the results you get from the auto-
mated Upright fixes (or if you just want to tweak 
the results), click on the Manual tab and you’ll see 
some sliders that you can adjust: Distortion (the 
bowing in/out), Vertical (if the building is tipping 
back or forward), Horizontal (if the scene needs 
to be tilted horizontally—as if you were holding 
a print in front of you and you moved one hand 
on one side toward you or away from you), Rotate 
(just lets you rotate the image to make it straight), 
Scale (zooms in the image toward you if you have 
white areas that appear after you apply a correc-
tion), and Aspect (if any of the corrections made 
the image look squashed/squatty or thin and 
stretched upward, this lets you counteract both).  
I tweaked this a little here to make the wall and the 
tower straighter.

tip: using the adjustable grid
When you’re trying to straighten things out 
like this, you might find it helpful to have a grid 
appear as you’re rotating. To do that, go under 
the View menu, under Loupe Overlay, and choose 
Grid. Once it appears, you can change its Size and 
Opacity by pressing-and-holding the Command  
(PC: Ctrl) key and clicking-and-dragging left/right 
on the two controls that appear at the top of the 
Preview area.

step ten:
Let’s look at just working on a very common lens 
problem using just the Manual sliders. In this case, 
the building looks like it’s leaning back (you see 
this a lot, especially when shooting up close with 
a wide-angle lens, like a 24mm, an 18mm, 16mm, 
and so on). Click on the Manual tab at the top of 
the Lens Corrections panel, so we can drag these 
sliders to fix the problem. 
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step eleven:
The quickest way to really understand what the 
Vertical slider does, is literally to just drag it way 
over to the right, then back way over to the left, 
and in a split second, you’ll totally “get it.” Try it 
(go ahead, I’ll wait). See, told ya! Now that you 
get it, just drag it to the left until the building looks 
straight (I generally look for a column or a straight 
edge of a building and try to get it straight). 

step twelve:
Here, I dragged the Vertical slider over to –32 to 
get that main column (one of four columns in the 
center) fairly straight. Of course, this left the white 
triangle gaps (from making such an extreme cor-
rection), so I turned on the Constrain Crop check-
box to crop away those areas. A final before/after 
is seen below. ■

ALL PHOTOS BY SCOTT KELBY



Under 
the 

Loupe When it comes to printing, either with your own printer or 
through an online print service, Lightroom has a lot to offer. You 
can create simple layouts for creating prints that you can frame, 
as well as more creative projects such as notecards or calendars. 

printing everything from  
standard-sized frame prints  
to cards and calendars
B Y  R O B  S Y L V A N
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Let’s start with something simple like creating a single print to 
match a standard frame size. Keep in mind that you can print 
any still file type Lightroom supports, so you don’t have to go 
through the motion of exporting a TIFF or JPEG just to bring that 
exported copy to the Print module. You can absolutely take a 
RAW photo, process it in the Develop module, then just switch 
to the Print module to create your layout, and print. 

single prints for framing
For this example, I’ll take a few family photos and get them ready 
for printing in 5x7 frames (the workflow would be the same for 
any size print). In this case, they’re all RAW photos that have 
been processed in Develop and are ready to go. Because the 
Folders panel is not visible in any other module, it can be really 
helpful (though optional) to put all of the photos you want to 
print in their own collection. With the photos selected in Grid 
view, press Command-N (PC: Ctrl-N) to open the Create Collec-
tion dialog. Give the collection a meaningful name, check Include 
Selected Photos, and click Create. Now I can head to the Print 
module, by clicking the Print button in the Module picker, and 
choose my layout.

I have three photos in this collection and I want to print them 
each as an individual 5x7 print. I could crop them using the Crop 
tool in Develop, but I don’t have to, and I’ll show you why in a 
moment. Even though I’m printing three different photos, each 
will be in a layout by itself. For this reason, I find the Single 
Image / Contact Sheet option in the Layout Style panel the easi-
est to use because the layout for each photo will be exactly the 
same—even if there’s a mixture of vertically and horizontally ori-
ented photos, as in my example. Let’s go through the steps for 
creating this layout.

step one: In the Toolbar below the preview area, set the 
Use drop-down menu to Selected Photos. (If you don’t see the 
Toolbar, press the T key to bring it back.) This way, if you have 
more photos in your collection than you’re planning to print at 
this time you can control which photos will be included in the 
print job. 

step two: From the Layout Style panel, choose Single  
Image / Contact Sheet. Think of this layout style as a simple grid 
where you control the num-
ber of rows and columns in 
the grid. When printing a 
single photo, you only need 
a single cell comprised of 
one row and one column. The benefit of this layout style over 
Custom Package is that the photo cell will be auto-populated 
with your photos, which is ideal when printing a batch of pho-
tos at the same size, like this example.

step three: Click 
the Page Setup button 
to choose your printer, 
the paper size, and the 
paper orientation. The 
paper size you choose will 
determine the minimum 
margin, so if you want to 
print borderless, be sure 
to choose a borderless 
paper size at this time.  
I chose a borderless 5x7 
paper size.

step four: Expand the Layout panel to create your layout 
grid. In this example, I zeroed out the Margins, set the Rows and 
Columns to 1 each, and set the Cell Size to the maximum to fill 
the 5x7 page.

step five: Expand the Image Settings panel and 
check Zoom to Fill and Rotate to Fit. In my example,  
I have two vertical photos and one horizontal, so by checking 
Rotate to Fit, Lightroom will automatically rotate the photos 
to fill the page—no matter their orientation. Since I haven’t 
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cropped these photos, I’m using the Zoom to Fill setting to tell 
Lightroom to fill the photo cell with the photo regardless of 
its native aspect ratio. Think of it as an auto-crop-on-the-fly.

step six: Expand the Page panel and turn off Photo Info. 
Note: This will depend on what you were doing previously in the 
Print module, but I had it turned on from another job, which is 
why the photo’s filename is showing below the print. Uncheck-
ing Photo Info turns that off so the photo can fill the page.

step seven: At this point my layout is done. Now, I can 
check each page in this print job by placing my cursor over the 
Page X of Y section of the Toolbar where it turns to a scrubby 
handle that I can click-and-drag right and left to see each photo.

step eight: Since I didn’t crop these photos to a 5x7 aspect 
ratio, and because I enabled Zoom to Fill, I know I have a little 
room to shift each photo within the print cell to possibly tighten 
up the composition. All I need to do is click-and-drag the photo 
up or down within the cell to get the look I want.

This is about the time in my workflow when I use the 
Print>Create Saved Print menu (or click the Create Saved 
Print button) to create a special collection with these pho-
tos and all of the layout settings I’ve used (which are auto-
matically saved as I make changes from this point forward). 
This type of collection is great when you know you’ll need 
to come back and do another print run, but it can also be 
a good way to save your work for short-term projects. You 
can always remove the collection when you know you won’t 
need it any longer.

The last step in the process involves configuring the 
Print Job panel for output. Regardless of your layout style, 
print size, or number of photos, the choices you make are 
based on whether you’re printing to a locally connected 
printer or going to upload JPEG versions of your layouts to 
an online print service. For this example, I’m going to use a 
connected printer. 

step one: Make sure the Print to drop-down menu at the 
top of the Print Job panel is set to Printer.

step two: If checked, uncheck Draft Mode Printing (this is 
useful for contact sheets).

step three: Check Print Resolution and leave it at the de-
fault of 240 ppi. This one setting is cause for great debate, and 
I encourage everyone to become familiar with their own printer: 
Do some tests at different resolution settings and print sizes to 
discover what looks best to your eyes. Until you have time to do 
that, I suggest leaving it at the default.
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step four: Check Print Sharpening and leave it on Standard. 
If, however, you have a workflow where you apply output sharp-
ening in some other software, then leave this unchecked. Set 
Media Type to Matte if you’re using matte paper; or Glossy for 
everything else. (If you’re not sure, look at the box your paper 
came in to see the recommended setting.)

step five: Click the Profile drop-down menu and choose 
the specific paper profile for the paper and printer you’re 
using. Perceptual is usually a good default choice for render-
ing Intent, but if you want to have more control over the 
process, I suggest going the soft-proofing route—a topic for 
another article.

step six: Click the Printer button to confirm the printer 
driver settings. This is the area where there’s the most variation 
in the process because it’s the crossroads between Lightroom, 
the operating system, and your printer driver software. The dia-
log that opens looks different on Windows and Mac, and the 
options within it can vary based on the printer manufacturer. 
(This is another good time to consult your printer manual.) Your 
goal here is: To confirm that the correct printer is selected; to 
select the correct media type based on the paper you’re using; 
and (most importantly), to disable all color adjustments in the 
printer driver because we already configured Lightroom to do 
the color adjustment back in Step Five. Once all settings are 
made and confirmed, click the Print button (PC: OK) to send the 
print job to your printer.

print adjustments
At the bottom of the Print Job panel is the Print Adjustment 
section. The purpose of the Print Adjustment controls is to 
give you the means to adjust the brightness and contrast 
of the output if you’re not satisfied with your results when 
Print Adjustment is disabled. If you’re happy with your prints, 
then leave this off. If you’re already practicing good color 
management and feel that your printer is in good working 
order, and your prints are coming out darker than expected 
(most common problem), then using the Print Adjustment 
sliders can help nudge your prints to a brighter place. There’s 
no way to preview the results in Lightroom: You just have to 
make an adjustment, print, evaluate the print, and refine the 
adjustment until you’re satisfied.

Now that you’re satisfied with your prints and all of your set-
tings are dialed in, create a template by clicking the + icon on 
the Template Browser panel. Give it a logical name and you can 
reuse these settings with other photos in the future. 

notecards
Another way I use the Single Image / Contact Sheet layout style 
is to print notecards. I’m currently fond of the Artist Cards from 
Museo (www.museofineart.com/index.php/products), but 
you can use what you have. I keep these very simple: a photo on 

the front, my name on the back, and blank on the inside. The key 
for making this layout work is to have an all-white image to put 
in the photo cell that will become the back of the card. I just send 
a copy of the photo I’m printing to Photoshop, fill it with white, 
and save it, so that back in Lightroom I have the original photo 
first and the all-white image behind it in the Filmstrip. Then, I can 
delete the white version when the job is done. Let’s go through 
the steps for creating a horizontal notecard by modifying the lay-
out from the last example. 

step one: Click the Page Setup button to choose your printer, 
the paper size, and the paper orientation, because this has likely 
changed. I like to put the paper in vertically so that, when folded, 
the bottom of the paper will become the front of the card and the 
top will be the back.

step two: Since we’re modifying an existing Single Image 
layout style, expand the Layout panel and set Rows to 2, leave 
Columns at 1, and reduce the Margins to the same value on all 
edges (this will vary with your printer and paper size, but in my 
case it’s .12"). To create an equal border around the image, set 
the Vertical Cell Spacing to a value that’s two times greater than 
the edge margins (because when the paper is folded down the 
middle, half is on the front and half is on the back). Set the Cell 
Size to fill the available space.

step three: Expand the Page panel and check the Identity 
Plate box. The sizing and placement of this is entirely up to you 
but, because I’m placing this on what will become the back of 
the card, I need to flip it 180° so that it appears right side up after 

http://www.museofineart.com/index.php/products
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printing and folding. To the right of the Identity Plate checkbox 
is a number set to 0°. Click that number and choose Rotate On-
screen 180° to flip the ID plate.

step four: Configure the Print Job panel for output. Because 
I changed paper type, I needed to change the paper Profile and 
Media Type to match, but the workflow is the same as the previ-
ous example.

step five: Click the Printer button to confirm media type 
and color adjustment settings. The settings you choose are de-
termined by your paper, but the process is the same as outlined 
in the last example. Be sure to save a template when you’re satis-
fied with your output results.

calendar prints
When printing calendars, I find the Custom Package layout style 
works best. I also like to save these as JPEGs for uploading to a 
print service or using as desktop wallpaper. There are a number 
of ways you can approach this project, but here’s one way to 
give you an idea.

step one: Gather up the photos you want to use on your 
calendar into a collection. 

step two: Create or, better yet, purchase a graphic that has 

the grid of days for each month of the year. I tried out the new 

Adobe Stock feature by doing a search from within Photoshop 

for a vector image of the 2016 calendar year. I found a simple 

design for $9.99 that had all 12 months in one image. Because it 

was a vector, I could resize as needed to break out each month 

into a single JPEG image, save those to a folder, import them into 

Lightroom, and add them to my calendar collection. Pretty slick!

step three: Because I’m 
saving this as a JPEG, I’m skip-
ping right to the Print Job panel 
to set the Print To drop-down 
menu to JPEG File. This reveals 
the Custom File Dimensions 
option, where you can check 
and enter the size you want 
to make your calendar. I chose 
8x10" at 300 ppi, but you can 
choose what you wish. By us-
ing this option, you’re not con-
strained to the sizes that your 
attached printer supports, and 
you can zero out the Margins. 
Configure other Print Job settings as discussed previously.

step four: Expand the Layout Style panel and choose Cus-
tom Package. This gives you maximum control over layout, and 
the ability to overlap your photos if you choose.

step five: Drag both the graphic for the first month and the 
photo you want to go with it onto the canvas, then position and 
resize them as desired. In this case, I wanted the photo to fill the 
area at the top and the calendar graphic to appear below. To 
ensure that the calendar graphic won’t overlap the photo, Right-
click the calendar image and choose Send to Back.

step six: Save the layout as a template.

step seven: Click the Print to File button to save the layout 
as a JPEG to the destination of your choosing. 

By saving the layout as a template, you can simply drag each addi-
tional month in turn onto the cell containing the calendar graphic 
to swap it. Then drag each new photo to go with that month into 
the photo cell at the top. Save each layout as a JPEG. ■

ALL IMAGES BY ROB SYLVAN EXCEPT WHERE NOTED
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Piccure+ is an interesting program for lens and 

minor camera-shake corrections. It runs either 

in standalone mode, or as a plug-in for Photo-

shop, Photoshop Elements, and Lightroom. It’s 

designed to work on images individually, or in 

batch mode for speedier processing (though 

faster machines are of benefit for this program).

piccure+Maximum 
Workflow B Y  S E A N  M c C O R M A C K

http://relaunch.piccureplus.com
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One interesting thing is that the lens fixes are done without 

profiles, making it useful for those with lenses that don’t have 

profiles available. In standalone mode, it recommends work-

ing with RAW files, and even provides RAW conversion based 

on the excellent open source DCRAW engine. Of course, 

we’re interested in the Lightroom plug-in version.

Piccure+ creates a preset in the Photos>Edit In menu as 

part of its installation procedure, so select it from the menu 

to begin. Installation itself is straightforward; just expand 

the download and run the installer. Piccure+ runs on both 

Mac and PC. 

layout
Piccure+ is laid out quite simply. There’s a main viewing area, 

with controls in a side panel to the right. To the left, below 

the main viewing area, are the zoom options. From the drop-

down menu, choose a zoom level from 5–400%, or use the 

Fit option to fit the image to the viewing area, or the 1:1 view 

to see the image at 100%. Use the Navigator on the right to 

move around the image when zoomed in.

On the bottom right of the main viewing area are the 

before and after options. Choose from a before/after side-

by-side view, a split view, or just the after (the default) view. 

Side-by-side view Split view
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right panel
On the right is the panel containing all the Piccure+ controls. 

The Menu allows you to choose from a series of options. You 

can opt to Participate in Lens Discovery research, which sends 

anonymous information about your lenses to Piccure. The 

data collected includes the camera ID, lens ID and software ID.  

This helps to build up a real-world database of lens informa-

tion. The next option allows you to change the Lens+ con-

trols to an Advanced version. In the last few options, you can 

choose to Update the application, view the manual (Hand-

book), or simply view an About dialog. 

The next control is where you choose between the two 

functions in Piccure+: Lens+ and Motion+. Lens+ sharp-

ens the image and corrects for optical aberrations, as well 

as offering denoising. Click on Lens+ to open a drop-down 

menu to choose Motion+, the other option. Motion+ lets you 

work on camera shake, offering options for Speed vs. Qual-

ity, amount of camera shake, Sharpness, and Denoise. Let’s 

look at these controls in more detail. 

lens+
To access the advanced settings in Lens+, choose Advanced 

Lens+ from the Menu. This adds a Speed vs. Quality slider. 

(As the work done by the plug-in is computationally intense, 

using it means having to wait for processing.) This slider 

allows you to make tradeoffs: speed if you’re in a hurry, or 

better accuracy, but with a longer wait. The version I’m using 

here is much faster than previous versions, but the process 

still takes time. 

The second control is Optical Aberrations, where you fix 

issues with the lens. Micro is good for TIFF or DNG files 

from smartphones. Piccure+ isn’t recommended for JPEG 

files. If the file is already sharp, then Micro is the best 

option. Normal is the default setting and will automatically 

correct optical issues in the lens. It won’t fix any chromatic 

aberration (CA); for this, you must set the slider to Strong. 

It’s also recommended that you choose Quality+ when this 

option is selected for best results. As mentioned, this will 

be slower, but give maximum quality to the processed file. 

[Piccure+ was updated to version 2.5 just before we went 

to press. Correcting chromatic aberrations can now be 

chosen independently—this option becomes visible for the 

Strong setting only.—Ed.]

Sharpness, the next control, sets the level of acutance 

in the file. This increases contrast along pixel edges, which 

translates as in increase in sharpness to our eyes. When 

zoomed in, the effect does look a little crunchy, but at print 

size (usually about 25% of screen size) and Fit view, it displays 

as an increase in sharpening. One thing that’s different about 

Lens+ sharpening is that the settings aren’t applied uniformly 

across the frame. Areas that need more processing, like the 

edges of the frame, will have more applied. Most lenses have 

a sweet spot in the center, with optical quality falling off at 

the corners. Lens+ is designed to fix this. 

The final slider is Denoise, which removes digital noise 

from the photo. Click the circle to turn the slider on.

My example file was shot with a Canon TS-E 24mm Mk1. 

It’s not the sharpest lens on the block, suffers from chromatic 

aberration, and can’t really be profiled, as different tilt-and-
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cool lights in a corridor, shot at 1/13 shutter speed. While 

it’s possible to handhold to 1/15, I’ve not succeeded here, so 

I’ll attempt to use Motion+ to correct it. Motion+ has four 

sliders: Speed vs. Quality, Camera Shake Intensity, Sharpness, 

and Denoise. 

The similar sliders work exactly as for Lens+, with Cam-

era Shake Intensity replacing Optical Aberrations. Camera 

Shake Intensity runs from Micro to Medium to Large. Gen-

shift settings change the optical properties. By zooming in to 

1:1 view, and pressing the Preview button, you can easily see 

what Piccure+ will do to the photo. Preview applies the pro-

cess to the current view. The processing is pretty impressive 

really, even at the edges of the frame.

Save Settings will make the current settings the new 

default, including window size and position. Reset will restore 

the default settings.

Piccure+ has recommended settings in the manual: Use 

Micro for smartphone and lenses with apertures of f/5.6 or 

slower; Normal for other lenses with no CA; and Strong to 

correct CA, with Quality set to Quality+, especially on lenses 

that are f/3.5 and faster.

motion+
With Motion+, you can remove small amounts of camera 

shake from your photos. This motion is based on the camera 

moving, giving a consistent motion in the whole image; it’s 

not for images where the camera is static, and the subject 

has moved. For my sample shot, I’m using an image of some 

Before After
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erally, it works best in the Micro to Medium range, so try 

these first. A downside to increasing the slider is ringing, 

but this can be mitigated using a higher Speed vs. Quality 

setting. Again, remember to use Preview to see changes as 

you make them.

There’s another tool to help fix camera shake, and it’s 

one that doesn’t appear directly on the interface. (Here’s an 

instance where it pays to read the manual.) SmartSpots are 

areas that help Motion+ detect the shake. Usually patterns 

or areas of high contrast work well. Areas of low contrast 

or faces are bad choices for these SmartSpots. To add a 

SmartSpot, hold down the Option (PC: Alt) key and then click 

on the area you want to use. To move a SmartSpot, simply 

hold Option (PC: Alt) and click somewhere else. To delete a 

SmartSpot, hold Ctrl and click anywhere. Remember to click 

Preview as you go to activate the new spot. 

output
Once you’ve reached a point where you’re satisfied, use Pro-

cess to apply the settings to the entire file. Click Close and 

then No, to close without applying any settings. Use Save to 

save the file and exit the plug-in.

Piccure+ does an admirable job of sharpening images. 

While some of the results onscreen appear quite sharp, it’s 

really in the printing where you’ll see the difference. As pixel 

peepers, the 100% view can look a little odd, but the proof is 

really in how the photo looks when printed. The sharpening in 

Piccure+ does go through to the print, but it still looks good. ■

ALL IMAGES BY SEAN McCORMACK
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Lightroom (the file size is much smaller, without compro-
mising quality). You make this choice in Lightroom (PC: 
Edit)>Preferences, under the External Editing tab in the 
File Format drop-down menu (shown here). 

Should I be converting my RAW files 
into DNG in Lightroom?
Well, there are definitely some advantages, both short- 
and long-term, but for some reason most of the photog-
raphers I talk to don’t convert to DNG (including me). Here 
are the advantages (in brief):

1. �DNG files are around 20% smaller in file size than the 
same RAW file (yet they maintain the RAW attributes 
and quality).

2. �When you edit a RAW file, the changes you make are 
saved within Lightroom, but also in a separate file called 
an XMP sidecar file. That way, if you give your RAW file 
to someone else, and you want it to have your edits, 
you give him the sidecar file, too. Without it, it’s the 
RAW file just like it came out of the camera. But with 
a DNG file, your changes are embedded right into the 
DNG file itself (no need for a separate sidecar file), so 
you can share the RAW image file, with your changes, 
in just one file. 

I feel like I’m spending a lot of my time 
scrolling up and down the panels in 
Lightroom, and it doesn’t feel like the 
streamlined workflow I keep hearing 
about. Are there keyboard shortcuts 
for jumping to different panels?
There aren’t any keyboard shortcuts, but there’s some-
thing you might like better. It’s called Solo Mode, and 
what it does is collapse 
all the panels except the 
one you want to work in. 
When you want to work 
in a different panel, you 
just click on it to expand 
it and the last one you 
were working in col-
lapses automatically. This 
makes the list of panels 
really short because you 
only see the titles for the 
panels you’re not work-
ing in. To turn this fea-
ture on (by the way, try 
it once, and you’ll never 
turn it off), just Right-click 
the top of any of the pan-
els (as shown here) and 
choose Solo Mode from 
the pop-up menu. Note: 
You’ll need to turn this on for each set of side panels and in 
each individual module (i.e. Develop, Library, etc.).

When I take a photo from Lightroom 
to Photoshop, it appears in Photoshop 
as a TIFF, but I have no idea if this is a 
good or a bad thing. Any thoughts?
It’s not a bad thing, but it wouldn’t be my first choice, 
only because TIFF files are pretty large (file-size wise), and 
before long you’ll have a bunch of TIFF files eating up 
space on your hard drive. That’s why I choose PSD (the 
native Photoshop format) for the file format for images 
that I send over to Photoshop and then bring back into 

SCOTT KELBY

ADOBE PHOTOSHOP   Lightroom Magazine ›  ›
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that one of those actions will fix it—well, it usually does. 
If for some reason it doesn’t, it’s time to quit Lightroom 
and restart. Your last resort is to restart your computer, but 
that’s pretty rare—not unheard of, but pretty rare. 

This is one of those Lightroom vs. 
Camera Raw questions: I know that 
in Camera Raw, when you’re using 
the Adjustment Brush, you can reset 
all the sliders to zero, except the one 
you want to work on, by clicking on 
either the plus or minus sign beside 
that slider, but there are no plus or 
minus sliders in Lightroom. Is there  
a way to do something similar?
Well, kinda (and I like it better than how it’s handled in 
Camera Raw). To reset all the sliders to zero in the Adjust-
ment Brush panel in Lightroom, just double-click directly 
on the word “Effect” (as shown circled here). The differ-
ence is that it doesn’t increase or decrease a particular 
slider; it resets all the sliders to zero, and now you can 
drag any slider you want in any direction you want. That 
seems more intuitive to me, but either way, it’s pretty 
close. Hope you find that helpful. 

Don’t forget to send in your Lightroom questions to 
lightroom@photoshopuser.com. We’ll see you back 
here next issue. ■

When I’m exporting a bunch of images,  
it seems to take forever. Is there any 
way to speed this up?
Actually, yes. Next time try this: Let’s say you have  
200 images; instead of selecting all 200 and exporting 
them, select 100 and export, then immediately select the 
remaining 100 images, and export those. Lightroom will 
let you export both sets of images at the same time—and 
it’s a lot faster overall. 

When I’m tethering into Lightroom, 
sometimes during the shoot it just 
stops working. What can I do to stop 
this from happening?
Umm. Nothing. Unfortunately, the tethering feature in 
Lightroom is a bit, shall we say, fussy, and sometimes it just 
stops working. It’s nothing you’ve done: It’s not your fault, 
but it’s one of those “It’s not a matter of if it will stop work-
ing; it’s what to do when it stops working” situations. So, 
here’s what to try first: If your camera goes to sleep (to save 
battery life) during the shoot, you’ll lose the connection. 
Try waking up your camera by pressing the shutter button 
halfway down. If that doesn’t work, turn the camera off 
and on. And if that doesn’t work, go under the File menu, 
under Tethered Capture, choose Stop Tethered Capture, 
and then turn tethered capture on again. My guess is 

›  ›  Lightroom Magazine   ADOBE PHOTOSHOP
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set in and out points
Video clips rarely start or stop exactly where you need them to; 
there’s usually at least several seconds, if not more, at the front 
that needs to be trimmed, and the same is often the case for the 
end of the clip. Lightroom lets you nondestructively set the in 
and out points on your video clips. Drag the video trim icons (two 
parallel lines) on the left and right to where you want the clip to 
start and end (see image for next tip). You can also set in/out 
points with keyboard shortcuts: Shift-I and Shift-O, respectively. 
Just drag the CTI where you want the in or out point and use the 
appropriate keyboard shortcut. The trims can always be adjusted 
later or reset to the original in/out points by dragging the video 
trim buttons.

poster frames and jpeg stills
By default, the thumbnail or larger preview image for a video clip 
is the first frame. You can set this to another frame that may be 
a better visual representation of the video by scrubbing to the 
frame that you want to use, clicking the frame icon in the lower 
right, and choosing Set Poster Frame. In the same menu you can 
also choose Capture Frame to create a JPEG file from the cur-
rently visible frame.

develop settings and video
If you try to go into the Develop module, a message tells you that 
video isn’t supported in that module. As with regular files, there’s 
a Quick Develop panel in the Library module, but the options are 
more limited than for still images.

There is a backdoor way that you can access more (though 
not all) of the Develop module functionality by synchronizing 
settings (see next tip), as well as by using Develop presets. At 

In addition to your regular still photos, you can also view and play 
video clips in Lightroom. And, in addition to just playing video 
clips, you can also trim the in and out points, capture a JPEG still 
from the footage, and apply some Develop adjustments. In this 
column, we’ll take a look at some tips and tricks for working with 
video in Lightroom.

filtering for video files
An easy way to zero in on the video files in a folder of hundreds 
of images is to use the Filter Bar in the Library module. Make sure 
you’re in Grid view (G), then choose the Metadata filter. Click 
on one of the filtering options that appear in columns above 
the thumbnails and change it to File Type. This will show you 
all the different file types in the targeted folder, allowing you to 
quickly show just the video clips. And while you’re looking at that 
metadata menu, be sure to check out all the different types of 
information you can use to filter your images.

previewing video files
You can see a general preview of the visual content of a video 
simply by moving your cursor left or right over the thumbnail in 
Grid view. Double-click on a thumbnail, or select it and press E 
to enter Loupe view. If the video playback control bar is thin and 
no frames are visible in the timeline, click the small gear on the 
right to expand it.

Here you can use the play/pause and forward/reverse buttons 

in the video playback control bar. Tapping the Spacebar will also 

serve as play/pause controls. You can manually preview the clip 

by dragging left or right on the playhead/current time indicator 

(CTI) to scrub through the video.

SEÁN DUGGAN

ADOBE PHOTOSHOP   Lightroom Magazine  ›  ›
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the video file on your hard drive, none of the Lightroom modifi-
cations will be applied. Select the file and choose File>Export, or 
simply click the Export button in the lower left.

In the Video section of the Export dialog, choose Video For-
mat and Quality. Selecting Original will replicate the original size 
and quality level of the video, while at the same time applying 
Lightroom Develop adjustments as well as any custom in/out 
points you may have set up.

The H.264 format is kind of like JPEG for video files; it’s very 
common and an excellent method of exporting video files with 
a reduced file size. In terms of Quality, choosing Medium or 
Low will result in a video that has a smaller resolution than a 
1920x1080p original.

If your aim is to use the exported video file in another video-
editing program, such as Adobe Premiere Pro, then I’d recom-
mend exporting the file at the Max quality level. For posting 
directly to a Web-sharing platform such as Facebook or You-
Tube, then a lower quality level may suffice.

exporting video files via the  
publish services
If your intent for a video clip is to post to a Web-sharing or social 
media service such as Flickr or Facebook, you can also use Pub-
lish Services in Lightroom to export directly to those services. 
When you set up a new publish service (or edit an existing one by 
double-clicking on it in the Publish Services panel), you get a dia-
log that contains options that are very similar to those found in 
the Export dialog. For instance, for my Facebook Publish Service,  
I have the video quality set to Medium. Of course, keep in mind 
that Facebook will probably apply its own compression scheme 
as the video is posting to your page. ■

the top of the Quick Develop panel, you can access all of your 
Develop presets in the Saved Preset menu, which is normally set 
to Default Settings. Depending on what settings are part of the 
presets, choosing a Develop preset may display a message telling 
you that not all Develop settings are possible with video, and a 
list of those that can be applied.

synchronizing settings from  
captured frames to video files
To access the Develop settings that can’t be applied directly to a 
video, first use the Capture Frame option mentioned earlier and 
create a JPEG file of a scene that’s representative of the entire 
video. Then bring that into the Develop module and adjust the 
image as desired (keeping in mind which of the settings can’t be 
applied to video).

If the Develop adjustments are specific to the video you’re 
working on and not something that might apply to future videos 
(see next tip), make sure the adjusted captured frame JPEG is 
selected. Command-click (PC: Ctrl-click) to select the video file 
in the Filmstrip, and click the Sync button in the lower right (if 
you’re in the Library module, it’s the Sync Settings button). In the 
Synchronize Settings dialog, you’ll see that many of the settings 
are grayed out and not available (these are the settings that can’t 
be applied to video files). Click Synchronize to apply the available 
settings to the video file.

using develop presets with video files
If you feel that the Develop settings that you’re applying to a cap-
tured frame could apply to other videos (such as with a stylistic 
effect like a split-tone effect, or a high-contrast black-and-white 
look), then consider creating a Develop preset that you can access 
from the Quick Develop panel. Just click the Create New Preset 
icon (+) in the header of the Presets panel, name it, select the 
Settings that you want to include, and click Create. When you 
apply a Develop preset from the Quick Develop panel, you’ll be 
informed that not all settings in the preset may work with video 
files. While presets may not be an option for adjustments that 
are specific to a particular video file, they can be an enormous 
timesaver when you need to apply a general stylistic look to a clip.

exporting video files
When you’re done setting the in/out points and applying the 
available Develop adjustments, you need to export it from Light-
room in order to use the video clip with those settings in other 
applications. This is a very important concept! If you just access 

ALL IMAGES BY SÉAN DUGGAN
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Product Reviews

Company: Rhino Camera Gear	 Price: �Starting at $1,100  
(w/Rhino Motion)

Web: www.rhinocameragear.com	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: Low noise motor; smooth and fluid motion; fit for macro-shots

	 Not: 

Motorized Camera Slider Enables Advanced  
Time Lapses
Review by Erik Vlietinck

A camera slider needs two features: It should allow for a smooth 

and fluid ride, and be lightweight yet sturdy. Most inexpensive 

sliders are one or the other, but rare are those that combine 

these two requirements into one. After a couple of months 

working with the Rhino Slider EVO Carbon and its associated 

Rhino Motion motor/controller unit, I can safely say it ticks all 

the boxes.

I tried the 24" Rhino Slider EVO with carbon rails (they also 

offer a PRO version with stainless steel rails, and both versions 

are available in 24" and 42" models). This slider has feet that 

compensate well for accidental terrain; legs that can be quickly 

positioned and synchronized; hand screws for the Rhino Motion 

motor; and a pre-installed belt. The slider has very smooth slid-

ing characteristics, as did its predecessor; but, as with most slid-

ers, motion fluidity—the capacity to maintain steady and slow 

movement across a slide—depends on the operator’s muscle 

control as much as on the slider itself. That’s where a motor 

comes in handy.

Mounting the Rhino Motion motor/controller assembly, with 

just a few turns of the hand screws, turned the slider into a fluid 

motion beast. In fact, I tried shooting an object at a distance of 

8" and there wasn’t the slightest choppiness.

Video is only one use for a slider, with time lapse a popular 

second. Time-lapse capabilities depend on the motor’s ability 

not only to move the camera very slowly, but also to hold posi-

tion when you’re taking long-exposure shots. The controller 

then becomes a vital part of the equation too. The Rhino Motion 

has two different time-lapse settings: Simple and Advanced. In 

Simple mode, the slider doesn’t control your camera, and acts 

pretty much like the automatic motion you can program to exe-

cute unassisted video slides. 

It’s simple to set up. You start by calibrating the motor, so 

it “knows” where the slider starts and ends, and set an edge 

buffer to avoid the camera bumping into the motor. Then, you 

program the desired starting point, travel distance, the time it 

will take to travel that distance, and an optional ramp.

Things become really interesting with Advanced Time Lapse, 

though, when the Rhino Motion works in shoot-move-shoot 

mode. In the Preferences screen of the controller, which has 

a simple menu structure for navigation and operation, you 

first select the camera you’re using. For each camera—Canon, 

Nikon, Pentax, Samsung, Panasonic, and Sony—a shutter con-

trol cable is available. 

On the Advanced Time Lapse screen you can set exposure, 

duration, and playback time. Those three are linked. For exam-

ple, if you change exposure and playback time, slide duration 

will be adjusted automatically. You can also have the Rhino take 

a test shot to check for exposure, set the travel distance, move 

the carriage to the in point and out point, and set a ramping 

time. Exposure can be dialed in to up to 2 minutes.

The Rhino Motion controller powers the motor and comes 

with a rechargeable battery—mine lasted for about 7 hours. 

You can also operate the controller from the mains. The unit 

can be mounted onto the motor with the strong magnets in 

its back. The motor is capable of pulling equipment of up to 

25 lbs horizontally and 5 lbs with the slider tilted at 45º—that’s 

enough power to move a DSLR with a heavy lens. The load 

capacity for the Carbon slider is 15 lbs for the 24" and 7 lbs for 

the 42"; the 24" and 42" PRO versions can handle up to 100 lbs 

and 50 lbs, respectively.

Motor noise is an important issue for video. Luckily, the 

Rhino Motion is very quiet: The noise was never picked up by 

the mic, except at the highest speed, and then only with the 

microphone mounted on the camera. ■

 �Rhino Slider EVO Carbon  
and Rhino Motion
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Palette and Color Scheme Creator
Review by Jay Nelson 

Compact Camera with Stabilized Zoom
Review by Steve Baczewski

 Olympus Stylus SH-2 

When we reviewed Genopal in 2007, we praised its innovative 

ability to create pleasing color palettes from your images. That’s 

still Genopal’s unique core feature: generating color combinations 

found in nature that human brains find pleasurable. (In contrast, 

many color schemes found on Adobe’s Kuler are synthetic, with 

oversaturated colors from plastic and other man-made products.) 

Genopal has now evolved to embrace mobility and multiple 

devices with an iPhone app, a website version, and a desktop 

version—each with slightly different features. The basic (but 

powerful) versions of all three are free, but you can pay to unlock 

additional features in the Windows version. For example, you can 

save five color palettes in the free versions, but unlimited palettes 

in the Pro version.

If you need a photo with colors appropriate for your project, 

Genopal now provides you with a conduit to Flickr. And, because 

colors evoke emotions or places, Genopal lets you find colors and 

palettes by word association (e.g., Dodger blue, whale, tranquil, 

beach, or Italy). This unique feature is designed to evolve as users 

tag colors with words, but even now provides inroads to useful 

colors. And you can always fine-tune a palette’s color combina-

tions with sliders.

The new pocket-sized, 16-megapixel Olympus Stylus SH-2 point-

and-shoot camera features a 25–600mm zoom lens (35mm 

equivalent) with 5-axis image stabilization, CMOS sensor, RAW 

capture, Wi-Fi, night mode, and 1080/60fps video.

Weighing less than 10 oz., the Olympus Stylus SH-2 has a tex-

tured shallow front grip with opposing thumb rest, so it feels solid 

and handles well. The camera starts up and focuses quickly, the 

zoom adjusts smoothly, and essential controls (like shutter release 

and the zoom lever) are well placed. To spare the user from 

needless menu scrolling, the SH-2 uses dedicated buttons and a 

quick-access menu for frequently used features such as ISO, WB, 

exposure compensation, etc. Although its 25–600mm variable 

f/3–6.9 aperture zoom is slow and comes up short compared to 

similar-class super zooms that cap out at 1000mm, the SH-2’s 

lens is sharp with good contrast, and its 5-axis image stabilization 

works quite well in handheld, low-light situations. Image quality 

is good enough to make 13x19" prints. 

To a great extent, this is an automated camera: Olympus omits 

both aperture and shutter priority modes leaving only a manual 

mode to change shutter speeds of 30 sec to 1/2000, or one of 

Genopal Pro 3 for Windows has a unique feature: You can 

feed it an image of an existing pattern and then automatically 

recolor it to produce a natural-looking alternate pattern, thus 

quickly generating multiple color options for a product, package, 

or other design. Now that’s a timesaver! (Genopal 2 for Mac is 

now free, but lacks this new feature.)

So, if you work with color, start generating natural color pal-

ettes and recoloring existing patterns using Genopal. In many 

cases, it will replace your color wheel—for the better. ■

two apertures f/3 or f/8.7 when shooting wide, or f/6.9 or f/20 

when shooting telephoto. The 3", 460,000-dot, touch-screen 

LCD holds up well in low light but washes out in bright light. 

The touch-screen LCD is especially practical, however, as you can 

swipe and zoom images in playback, change focus area while 

shooting video, and release the shutter when shooting stills—no 

menu scrolling though.

 Wi-Fi works well on the Olympus Stylus SH-2 and is easily 

set up for mobile viewing and shooting from a smartphone. One 

annoying feature, however, is that Olympus doesn’t supply a bat-

tery charger, so it’s necessary to charge the battery in-camera. ■

 Genopal PC v3 and Genopal iOS v1

Company: Genopal 	 Price: �Free, Windows 
Pro version $19.99

Web: www.genopal.com	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: Immediate, pleasing color palettes; recoloring patterns; price

	 Not: Mac version left behind; iPhone Pro version not yet available

Company: Olympus	 Price: $399

Web: www.getolympus.com	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: 5-axis image stabilization; image quality; sharp lens 

	 Not: No continuous/burst RAW capture

 ›  ›  GET THE SCOOP ON THE LATEST GEAR

http://www.genopal.com
http://www.getolympus.com/us/en/digitalcameras/point-shoot/sh-2.html
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Plug-in for Adobe Illustrator  
Review by David Creamer

The Body You’ve Always Wanted
Review by Michael Corsentino

ControlFreak, a new suite of tools for Adobe Illustrator from Hot 

Door, adds new panels and tools to control, organize, and label 

your art, plus a Dashboard panel to access them. 

The ArtTags panel lets you select objects or groups and add 

them to a specific category. You can then show the objects with 

nametags and get a count. The tags cannot be offset from the 

objects or printed.

The ArtLabel tool labels objects with specs: Select such 

options as stroke, fill, transparency, font, etc. The labels print, 

but there’s no way to hide them. And, if changes are made, the 

labels don’t auto-update.

DocLabel is a similar tool, but it creates a single label with 

information about the artboards, groups, objects, and the date 

and time. While some info auto-updates, the date and time do 

not. Comments: The date/time should automatically update, and 

it would be useful to have a sublayer count option. 

The ParticuLayer panel creates groups of layers that can be 

hidden, locked, and printed—with the same layer belonging to 

multiple categories. Currently, it only works with top-level layers. 

The NitPicker panel is like the Select menu on steroids—

arguably the best panel in the suite. It lets you create presets 

with multiple-selection criteria. 

They say good things come to those who wait. Phase One users, 

including this reviewer, have been waiting a long time for a cam-

era body on par with Phase One’s sophisticated IQ series digital 

backs. Happily, the wait is over and it’s definitely been worth it. 

Phase One’s new XF Camera body, along with a new IQ3 genera-

tion of digital backs, new lenses, and an update to its venerable 

Capture One Pro 8 software, all have a lot to love. 

Built from the ground up with the future in mind, Phase One’s 

new XF camera body is a rugged, beautifully designed, well-

thought-out modular system with an enviable feature set and a 

price point to match. It’s compatible with Phase One IQ1, IQ2, and 

IQ3 series digital backs. 

Standouts include: the new patent-pending, in-house devel-

oped, 1,000-pixel CMOS Honeybee Autofocus Platform (HAP-1); 

snappy performance via all-new electronics and faster processors; 

built-in wireless triggering for Profoto Air-compatible strobes; and 

a flexible new user interface (UI). The UI consists of a highly cus-

tomizable touch screen, dials, buttons, and firmware, which is easy 

The FixPix panel seems to bypass the 0.1-pt limit for nudging 

when the Scale Distance with Zoom option is selected. Other 

options include displaying X/Y values for anchor points, and 

the ability to precisely edit the X/Y values of an anchor point 

and its in-and-out handles. 

By automatically or manually logging in and out, the 

TimeSheet panel not only lets you keep track of all time spent 

in a document, you can also export the file to a .csv format 

(spreadsheet). Now, if it only worked over all the Adobe Creative 

Cloud products…. ■

to upgrade on a promised regular basis. The XF also introduces a 

new 90° prism and a classic, modular, waist-level viewfinder. 

Rounding out the next generation of Phase One’s imaging tools 

are: Three new IQ3 series digital backs designed for use with the 

XF camera system, available in 50-, 60-, and 80-megapixel reso-

lutions; two new Phase One Schneider Kreuznach Leaf Shutter 

lenses (120mm and 35mm) designed to resolve beyond 100 mega

pixels; and Capture One Pro 8.3’s impressive new features. ■

 ControlFreak 

 Phase One XF Camera System

Company: Hot Door	 Price: $179  

Web: www.hotdoor.com	 Rating: ◆ ◆ ◆ ◆

	 Hot: Many useful features sorely missing from Illustrator 

	 Not: Cost; some improvements needed in most panels

Company: Phase One	 Price: �$7,990 (body & prism only);  
Contact dealer for upgrade pricing 

Web: www.phaseone.com	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: Autofocus system; touch-screen controls; firmware upgrades

	 Not: Single non-movable focus point; price 

http://www.hotdoor.com/controlfreak/overview
http://www.phaseone.com/en/Products/Camera-Systems/XF-Camera-System.aspx
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Add on the Module Pro for Inexpensive  
Sensor-Based Photography
Review by Erik Vlietinck

With Hähnel’s Captur Remote Control & Flash Trigger, you can 

remotely control your camera and off-camera flashes. Captur 

is a modular system: You can start with the Remote Control, 

which includes a transmitter and a receiver and then add other 

modules. The Remote Control comes with a shutter cable for 

Nikon, Canon, Olympus, Panasonic, or Sony and allows remote 

control of your camera or flash using a 2.4-GHz frequency band 

for up to 100 m (109 yds).

Expand the basic system with the Captur Module Timer inter-

valometer or the more sophisticated—and fun—Captur Mod-

ule Pro ($119.95). The latter uses built-in laser, light, sound, and 

infrared sensors as triggers, plus it includes an intervalometer 

and an AUX port for external sensors. It comes with an infrared 

transmitter. The system allows you to take shots that would oth-

erwise be very difficult, such as lightning, drops of falling liquid, 

exploding balloons, light bulbs being shot, and more.

All of the Captur modules will run on two AA batteries for at 

least 60 hours. The Module Pro devices can also run on external 

power via a 5V adapter, using a built-in micro-USB port. The 

entire system is robust, wrapped in rubber, and I believe will 

withstand professional and frequent use well.

Some of the great things about the Module Pro is that you 

can set laser, sound, and light sensitivity, as well as a delay in 

hundreds of seconds before it triggers your flashes or camera. 

You can also set a burst or bulb-exposure length. The inter-

valometer has long exposure capabilities and the ability to use 

two intervals nested into each other. Best of all, you can also 

start time lapsing when a sensor gets triggered. ■

 Captur Remote Control & Flash Trigger

Company: Hähnel Industries Ltd.	 Price: Starting at $99.95  

Web: www.hahnel.ie	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: Battery runtime; sophisticated trigger capabilities, menu navigation

	 Not: 

Better, Faster, Smarter Layouts 
 Review by Michael Corsentino

 �SmartAlbums 2

The innovative team at Pixellu recently released version 2 of Smart-

Albums, their popular drag-and-drop, album-design software. 

SmartAlbums 2 builds on the clean, easy-to-use foundation it’s 

known for, with a redesigned user interface and a host of signifi-

cant new features. 

With the new spread thumbnails, you can view the entire 

album design and quickly re-order pages. Using the Designer 

View feature, users can effortlessly make modifications, custom-

ize existing layouts, or create new designs and save them as tem-

plates. Matted albums are now fully supported, which is a real 

boon for photographers interested in offering these timeless, but 

until now, difficult-to-design albums.

 An optional, subscription-based Cloud Proofing service is 

available, giving photographers a complete solution for their 

workflow and client feedback. (Pixellu offers a free 1-year sub-

scription to Cloud Proofing with your SmartAlbums 2 order.) 

Robust template features, such as favorites, rejects, and smart 

technology that promotes often-used layouts, provide more time-

saving technologies. Seamless album resizing, and support for 

background colors, text, and opacity offer maximum flexibility.

Useful tools such as built-in, standard image-ratio conver-

sions—1:1, 2:3, and 3:4—assure images are the right aspect 

ratio for DSLR and medium-format shooters alike. Images can 

also be flipped vertically and horizontally. 

With an eye toward the future, SmartAlbums 2 is now com-

patible with all major RGB color spaces including Adobe RGB 

(1998), sRGB, ProPhoto RGB, ColorMatch RGB, and Apple RGB. 

Additional amenities such as image-resolution warnings, a 

new inside bleed feature (for album companies who trim near the 

page gutter), support for myriad album sizes (as slim as 20x8"), 

and an inspector with detailed information about your project 

images, resolution, color space, album company, and size all make 

SmartAlbums 2 a very smart application indeed. ■

Company: Pixellu	 Price: $299 (Upgrade: $99) 

Web: www.pixellu.com	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: Interface; Cloud Proofing; matted album support

	 Not: 
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 ›  ›  GET THE SCOOP ON THE LATEST GEAR

http://www.hahnel.ie
http://www.pixellu.com
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The subtitle for this book is “The Complete Guide for Photog-

raphers,” and at more than 700 pages, it’s comprehensive. The 

author has been involved with Lightroom for a decade—since 

before there was actually a program named “Lightroom.” Few 

understand the inner workings of the program as well as he. This 

book is designed for both those brand new to Lightroom and 

experienced users updating to the latest version. The author’s 

Facebook page (www.facebook.com/MartinEveningPhotoshopAnd-

Photography) contains updates on new features and changes to 

the program subsequent to the book’s publication. The reader 

should start at the beginning and follow straight through to the 

end because the author has organized the book to follow the 

most logical Lightroom workflow. The Library and Develop mod-

ules in Lightroom get most of the attention (as they should), but 

the author also covers exporting, printing, presenting, and even 

black-and-white conversions

Macro photography is shooting images life size (1:1) or larger 

than life size. This author defines macro as 1:1 and “close up” 

for images up to 10:1. He uses a series of his photos to dem-

onstrate various techniques and challenges that face photog-

raphers shooting small objects and other up-close photos. In 

most cases he presents an image and describes how he shot 

the photo and why he shot it that way. Most of the two-page 

layouts show a large image in which the reader can easily see 

the detail of the image and any special aspects of the shot 

described in the accompanying text. Most of the examples also 

include either a lighting diagram or a description of the lighting 

setup. The author also discusses hardware specific to macro 

photography. You’ll also find numerous references to focus 

stacking (in Photoshop, use Edit>Auto-Blend Layers with the 

Stack Images option).

Shoot Macro: Techniques for Photography  
Up Close

The Adobe Photoshop Lightroom CC/Lightroom 6 
Book: The Complete Guide for Photographers

By Stan SholikBy Martin Evening

 

Publisher: Adobe Press	 Pages: 722 (plus, associ- 
			   ated website)

Website: www.adobepress.com

	 Price: $59.99	 Rating  ◆ ◆ ◆ ◆ ◆

Publisher: Amherst Media	 Pages: 127

Website: www.amherstmedia.com

	 Price: $27.95	 Rating:  ◆ ◆ ◆

https://www.facebook.com/MartinEveningPhotoshopAndPhotography
https://www.facebook.com/MartinEveningPhotoshopAndPhotography
http://www.adobepress.com/store/adobe-photoshop-lightroom-cc-lightroom-6-book-the-complete-9780133929195
http://www.amherstmedia.com/miva/merchant.mvc?Screen=PROD&Store_Code=AM&Product_Code=2028&Category_Code=AB
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To: Frankie
From: KelbyOne Help Desk

Photoshop has a couple of ways to fix perspective, 

where the top of a tall object seems to be leaning away 

from the camera. This problem can also occur when 

shooting downward at an object, where the bottom 

part of the subject seems smaller. You can also run into 

this sort of dilemma when shooting parallel to a subject, 

with the far end of the subject appearing too small. (The 

top, bottom, or far end seems smaller because it’s far-

ther from the lens.)

Nested with the Crop tool (C) is the aptly named Per-

spective Crop tool. To use the tool with either vertical 

or horizontal problems, simply click on each of the cor-

ners of the subject; then drag the top, bottom, and side 

anchor points to the outer edges of the area that you 

want to include in the crop; and press the Enter key. 

The image is automatically cropped to make it appear 

as if you’d shot the image straight on from the center 

of the subject. 

If part of your subject disappears after cropping, 

because the subject nearly filled the frame or the amount 

of perspective cropping was large, use the Edit>Undo 

command, unlock the Background layer (click the lock 

icon to the right of the layer name or, in earlier ver-

sions of Photoshop, double-click the layer name Back-

ground and rename the layer), use Image>Canvas Size 

to expand the canvas, then crop again.

If the subject itself isn’t square or rectangular, you 

can use the Perspective Crop tool on something within 

the image that’s square or rectangular, then drag the 

top, bottom, and side anchor points to the outer edges 

of the image.

Photoshop also offers Edit>Transform>Perspective: 

Select this command and a bounding box appears 

From The Help Desk	
›  ›

The KelbyOne Member  
	 HELP DESKS 

Are you taking advantage of the Help Desks at the KelbyOne member website? This is the place where you can get all of your 

Photoshop and Lightroom questions answered either by other KelbyOne members or by our Help Desk experts. Not only that, you 

can get photo and computer gear help and advice, as well. What are you waiting for? Visit the Community section on the 

KelbyOne member site today! ■

around the layer. Drag a corner anchor point to 

straighten the image. (Note: The layer must be unlocked 

to use the Transform commands.)

Using the grid in Photoshop can help you make more 

precise adjustments. You can make the grid visible by 

using the View>Show menu, or with the keyboard short-

cut Command-Apostrophe (PC: Ctrl-Apostrophe). The 

size of the grid and number of subdivisions are defined 

in the Photoshop CC (PC: Edit)>Preferences>Guide, 

Grid & Slices dialog. Showing the grid can help you 

place the Perspective Crop tool’s anchor points more 

accurately. You can also use guides to help place anchor 

points. Use the View>New Guide command if you 

know precisely where you need the guide. (You can also 

add a new guide anywhere and use the Move tool [V]  

to drag it into position.) If you have the rulers visible 

(Command-R [PC: Ctrl-R]), you can drag a guide from 

either ruler onto the image. The grid and guides are 

non-printing and can be hidden after use through the 

View>Show menu. You can also hide the grid by using 

its shortcut a second time.

In Camera Raw, you fix perspective in the Lens Cor-

rections panel’s Manual tab using the Vertical or Hori-

zontal sliders. (Tip: Part of the subject may disappear 

off the edges of the image when using the various 

Transform sliders. Not a problem! Simply use the Scale 

slider to reduce the size of the image until everything 

you need is visible, then if desired, use the Crop tool [C] 

in Camera Raw to remove the now-empty parts of the 

image.) The Manual panel also includes sliders for rotat-

ing an image, correcting barrel distortion or pin cush-

ioning, and the Aspect slider to make an image taller 

and skinnier or shorter and fatter. 

I shot a photo of a building, but it was so tall that it looked like it was leaning away from the cam-
era. What are my options in Photoshop for making the building look straight?—Frankie

C O L U M N  › ›

 BY PETER BAUER

Answers to Photoshop and gear-related questions

http://kelbyone.com/my-account/helpdesk/
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